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EEDDIITTOORRIIAALL

WELCOME TO ANOTHER ISSUE OF FULL CIRCLE!

The usual Python, LibreOffice and Inkscape HowTo's are here, but Nicholas has taken
this month off. The email said something about him getting married. Sounds like a

lame excuse to me. Replacing this month's Blender article is a short piece I wrote a little
while ago on restoring old photographs using GIMP. My initial post on Google+ (using a
different source photo) managed to get me on the 'What's Hot' list, so that's my claim
to fame. We also have an interesting HowTo on mashing Google Tasks, the command
line, and Conky. This results in task notifications via Conky. Very interesting.

Many thanks to all of you who stepped up and sent in your desktop screens. In honor
of such bravery, I've tweaked the layout to give larger screens. While that may seem
great, it doesn't leave much space for the text. We'll see how it goes and maybe next
month I'll give it a 2.1 release.

Plenty for you gamers this month. I'm reviewing Euro Truck Simulation 2, and this
month's Ask The New Guy is discussing Steam and the Ubuntu Software Centre.
Speaking of games, please send in your game reviews. Once again, from dozens of
writers, most have left and we're down to just one regular writer (Joe). Please, give
generously!

Well, I shan’t take up any more of your time. Keep sending in your articles and letters
and enjoy the issue.

All the best, and keep in touch!
Ronnie

ronnie@fullcirclemagazine.org

This magazine was created using :

Full Circle Podcast
Released monthly, each episode
covers all the latest Ubuntu news,
opinions, reviews, interviews and
listener feedback. The Side-Pod is
a new addition, it's an extra
(irregular) short-form podcast
which is intended to be a branch
of the main podcast. It's
somewhere to put all the general
technology and non-Ubuntu stuff
that doesn’t fit in the main
podcast.

Hosts:
• Les Pounder
• Tony Hughes
• Jon Chamberlain
• Oliver Clark

http://fullcirclemagazine.org

mailto:ronnie@fullcirclemagazine.org
http://www.scribus.net
http://www.gimp.org
http://www.libreoffice.org
http://creativecommons.org/
http://fullcirclemagazine.org
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UUBBUUNNTTUU NNEEWWSS
Written by The Ubuntu News Team

MIR PLANS IN 13.10
Jono Bacon announces that Mir,

Ubuntu’s new display server
designed for fast, efficient, and
extensible display across devices,
is to be made default as XMir (an
implementation of X on Mir) for
users running open-source drivers
in Ubuntu 13.10 along with Unity 7.
He also mentions proprietary
drivers will fall back to X in 13.10
but will get XMir support in 14.04
LTS, and he explains the decision is
necessary to make Mir production-
stable for 14.04 LTS. Bacon also
answers users' possible questions.
http://fridge.ubuntu.com/2013/06/
27/mir-plans-in-13-10/

Various press outlets and blogs
have covered this change. Here’s a
selected sampling from our
editors:
• Mir To Ship As Default Display
Server in Ubuntu 13.10
-http://www.omgubuntu.co.uk/201
3/06/mir-display-server-to-ship-
default-in-ubuntu-13-10
• Ubuntu to default to Mir stack in
13.10, Kubuntu will not follow -
http://www.zdnet.com/ubuntu-to-
default-to-mir-stack-in-13-10-

kubuntu-will-not-follow-
7000017443/
• Mir, XMir and Unity 7 to land in
Ubuntu 13.10 by default -
http://iloveubuntu.net/mir-xmir-
and-unity-7-land-ubuntu-1310-
default
• Ubuntu 13.10 Saucy Salamander
Switching To Mir Display Server By
Default -
http://www.webupd8.org/2013/06
/ubuntu-1310-saucy-salamander-
switching.html
• XMir will be Default in Ubuntu
13.10, Fallback X Session to be
Removed from Ubuntu 14.04 LTS! -
http://www.techdrivein.com/2013/
06/xmir-will-be-default-in-ubuntu-
1310.html
• Mir in Ubuntu 13.10,
Benchmarking, and More -
http://www.jonobacon.org/2013/0
6/28/mir-in-ubuntu-13-10-
benchmarking-and-more/

13.10 (SAUCY

SALAMANDER) ALPHA 1
RELEASED!

Kate Stewart announces the
availability of the first Alpha
release of Saucy Salamander from

Kubuntu, Lubuntu, UbuntuKylin,
and Ubuntu GNOME. She points
out that there have been some
adjustments to the release
schedules, lists the release details
for Ubuntu flavors that have
participated in the release, and
provides links to the downloadable
images.
http://fridge.ubuntu.com/2013/06/
27/13-10-saucy-salamander-alpha-
1-released/

SHARE YOUR

INFRASTRUCTURE, WIN A

PRIZE
Jorge O. Castro welcomes us to

the Charm Championship and
announces that there is "a total of
USD $30,000 in major prize
money." He provides links to the
competition rules and how to enter
the competition.
http://www.jorgecastro.org/2013/
07/01/share-your-infrastructure-
win-a-prize/

Also be sure to check out the
related post at the Canonical Blog:
“The Juju Charm Championship
begins”
http://blog.canonical.com/2013/07

/01/the-juju-charm-championship-
begins/

UBUNTU DEVELOPER

SUMMIT: 27-29 AUGUST

2013
The Ubuntu Developer Summit

will be taking place Tuesday, 27th
Aug 2013 through Thursday, 29th
Aug 2013 from 2pm UTC to 8pm
UTC. As usual, the event is
completely open and accessible to
everyone at summit.ubuntu.com.
http://fridge.ubuntu.com/2013/07/
11/ubuntu-developer-summit-27-
29-august-2013/

MARK SHUTTLEWORTH: TWO

WEEKS WITH MIR
Mark Shuttleworth writes about

his experience using Mir for the
past two weeks. He notes that the
system feels smoother using Mir,
and that X and Compiz appear to
be using less memory and fewer
CPU cycles than when X was
directly handling the hardware. He
then goes on to discuss
competition, the importance of
making the Mir decision, and

http://fridge.ubuntu.com/2013/06/27/mir-plans-in-13-10/
http://www.omgubuntu.co.uk/2013/06/mir-display-server-to-ship-default-in-ubuntu-13-10
http://www.zdnet.com/ubuntu-to-default-to-mir-stack-in-13-10-kubuntu-will-not-follow-7000017443/
http://www.zdnet.com/ubuntu-to-default-to-mir-stack-in-13-10-kubuntu-will-not-follow-7000017443/
http://iloveubuntu.net/mir-xmir-and-unity-7-land-ubuntu-1310-default
http://www.webupd8.org/2013/06/ubuntu-1310-saucy-salamander-switching.html
http://www.techdrivein.com/2013/06/xmir-will-be-default-in-ubuntu-1310.html
http://www.jonobacon.org/2013/06/28/mir-in-ubuntu-13-10-benchmarking-and-more/
http://fridge.ubuntu.com/2013/06/27/13-10-saucy-salamander-alpha-1-released/
http://www.jorgecastro.org/2013/07/01/share-your-infrastructure-win-a-prize/
http://blog.canonical.com/2013/07/01/the-juju-charm-championship-begins/
http://blog.canonical.com/2013/07/01/the-juju-charm-championship-begins/
http://fridge.ubuntu.com/2013/07/11/ubuntu-developer-summit-27-29-august-2013/
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UBUNTU NEWS
expresses his desire for other
variants and distributions to
consider Mir.
http://www.markshuttleworth.com
/archives/1269

Also be sure to check out the
the following other stories relating
to Mark’s blog post:
• Mark Shuttleworth after running
Mir for two weeks: "I’m
nonetheless surprised that the
system feels smoother than it did
pre-Mir"
-http://iloveubuntu.net/mark-
shuttleworth-after-running-mir-
two-weeks-i’m-nonetheless-
surprised-system-feels-smoother-
it-did
• Mir For everyone -
http://www.jonobacon.org/2013/0
7/10/mir-for-everyone/
• Mark Shuttleworth: 'Mir has
delivered what we hoped’ -
http://www.zdnet.com/mark-
shuttleworth-mir-has-delivered-
what-we-hoped-7000017897/

NOTICE OF SECURITY BREACH

ON UBUNTU FORUMS SITE
Jane Silber writes that there

has been a security breach on the
Ubuntu Forums site,
ubuntuforums.org. She explains
what has happened and says that

Canonical is working with software
providers to address how the
attackers were able to gain access.
Jane also says Canonical has begun
the process of notifying all users
whose details were compromised
by email and apologizes “for the
breach and ensuing
inconvenience.”
http://blog.canonical.com/2013/07
/21/notice-of-security-breach-on-
ubuntu-forums-site/

The security breach is also
covered in the following stories:-
• Ubuntu Forums Hacked, 1.8
Million Passwords, E-Mails &
Usernames Stolen -
http://www.omgubuntu.co.uk/201
3/07/ubuntu-forum-hacked-users-
advised-to-change-passwords
• Ubuntuforums hacked, "if you
were using the same password as
your Ubuntu Forums one on
another service (such as email), you
are strongly encouraged to change
the password on the other service
ASAP" -
http://iloveubuntu.net/ubuntuforu
ms-hacked-if-you-were-using-same-
password-your-ubuntu-forums-
one-another-service-such
• Ubuntu forums hacked; 1.82M
logins, email addresses stolen -
http://www.zdnet.com/ubuntu-
forums-hacked-1-82m-logins-email-

addresses-stolen-7000018336/
• Ubuntu forums breached, 1.8m
passwords pinched -
http://www.theregister.co.uk/2013
/07/21/ubuntu_forums_breached_
18_passwords_pinched/

WELCOME NEW MEMBERS

AND DEVELOPERS
Results from the Developer

Membership Board Meeting 17
June 2013:

Approved as a Contributing
Developer:
• Louis Bouchard (
https://launchpad.net/~louis-
bouchard |
https://wiki.ubuntu.com/LouisBouc
hard )

At the the Developer
Membership Board meeting 2013-
07-01:
• MOTU Application and PPU
upload rights for the Ubuntu
Server packageset granted to
Robie Basak
-https://wiki.ubuntu.com/RobieBas
ak/ServerDeveloperApplication

The 12:00 Membership Board
welcomed one new member on
July 17th, 2013.
• Elias Ps

(https://wiki.ubuntu.com/eliasps |
https://launchpad.net/~eliasps)

Many Thanks to the Ubuntu
News Team for their contribution
this month.

News this month comes from:

https://wiki.ubuntu.com/UbuntuW
eeklyNewsletter/Issue323

https://wiki.ubuntu.com/UbuntuW
eeklyNewsletter/Issue324

https://wiki.ubuntu.com/UbuntuW
eeklyNewsletter/Issue325

https://wiki.ubuntu.com/UbuntuW
eeklyNewsletter/Issue326

http://www.markshuttleworth.com/archives/1269
http://iloveubuntu.net/mark-shuttleworth-after-running-mir-two-weeks-i?m-nonetheless-surprised-system-feels-smoother-it-did
http://www.jonobacon.org/2013/07/10/mir-for-everyone/
http://www.zdnet.com/mark-shuttleworth-mir-has-delivered-what-we-hoped-7000017897/
http://blog.canonical.com/2013/07/21/notice-of-security-breach-on-ubuntu-forums-site/
http://www.omgubuntu.co.uk/2013/07/ubuntu-forum-hacked-users-advised-to-change-passwords
http://iloveubuntu.net/ubuntuforums-hacked-if-you-were-using-same-password-your-ubuntu-forums-one-another-service-such
http://www.zdnet.com/ubuntu-forums-hacked-1-82m-logins-email-addresses-stolen-7000018336/
http://www.zdnet.com/ubuntu-forums-hacked-1-82m-logins-email-addresses-stolen-7000018336/
http://www.theregister.co.uk/2013/07/21/ubuntu_forums_breached_18_passwords_pinched/
https://launchpad.net/~louis-bouchard
https://wiki.ubuntu.com/LouisBouchard
https://wiki.ubuntu.com/RobieBasak/ServerDeveloperApplication
https://wiki.ubuntu.com/eliasps
https://launchpad.net/~eliasps
https://wiki.ubuntu.com/UbuntuWeeklyNewsletter/Issue323
https://wiki.ubuntu.com/UbuntuWeeklyNewsletter/Issue324
https://wiki.ubuntu.com/UbuntuWeeklyNewsletter/Issue325
https://wiki.ubuntu.com/UbuntuWeeklyNewsletter/Issue326
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Last month, I started working
my way through survey

suggestions. However, to start
with, I felt it prudent to move
through the most common
questions in a short-answer
format. Starting this month, I will
be devoting these articles to one
or two topics from the survey
results, beginning with setting
default applications for programs,
creating new MIME types, and
assigning icons to said MIME types.
For those of you wondering what
MIME types are, they are the name
given to the system for managing
file types by extensions. For
example, the MIME type for a text
document (*.txt) is text/plain. All
MIME types consist of a type and a
subtype (in the format
type/subtype).

DEFAULT PROGRAMS

The first spot to check for
changing a default application is in
System Settings -> Details ->
Default Applications. Here you can
set Web, Mail, Calendar, Music,
Video and Photos application

defaults.

The second spot to check is the
properties list of a file. You can
right-click a file whose default you
wish to change, and then head to
the tab Properties/Open With. If
you see the application you wish to
use in the list, select it and hit the
button “Set as Default”. I will note
– this is how it appears in Nautilus,
and I'm not sure if the wording is
the same in KDE/XFCE. If you can't
find this option, or the application
you want to use isn't listed, move
on to the next step.

The last method I would
suggest using is xdg-mime. It's a
command-line tool to manage the
XDG settings (xdg is the framework
for dynamically choosing a
program to load a file type – just
try it by running xdg-open file). You
could also edit
.local/share/applications/default.li
st or
/usr/share/applications/default.list
manually – but I would recommend
using xdg to make these changes,
as it avoids duplicates and
formatting issues.

The way you would go about
checking a file's default application
is as follows:

xdg-mime query default
application/pdf

evince.desktop is the output
telling you the default application.
In this case, Evince

xdg-mime default kde-
kpdf.desktop application/pdf

changes the default to KPDF.

xdg-mime query default
application/pdf

kde-kpdf.desktop is the output in
this case.

After this, running xdg-open on
a pdf file should open it in KPDF
instead of Evince. You must, of
course, have installed the
application first. If you're unsure
what the desktop file is, you can
run the following commands

sudo updatedb

updates the database for locate

locate *.desktop|grep
application | more

will locate all the desktop files on
your system, and search through
them for your supplied application

If you're unsure what the MIME
type is, you can run the following
command:

xdg-mime query filetype file

Replace file with your actual file
(including the path), and it will spit
out the information you need for
creating rules for that type. Keep
in mind that for the web browser,
you'll need to set the default for
both x-scheme-handler/http and x-
scheme-handler/https.

MIME TYPES

Very, very occasionally you may
stumble upon a file type that
doesn't have a MIME type. If this is
the case, you can make certain by
running the following:

grep 'extension'
/etc/mime.types

CCOOMMMMAANNDD && CCOONNQQUUEERR
Written by Lucas Westermann

DDeeffaauullttss aanndd MMIIMMEEss
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Lucas has learned all he knows from
repeatedly breaking his system, then
having no other option but to
discover how to fix it. You can email
Lucas at: lswest34@gmail.com.

If you don't get a result here,
the extension (for example, txt for
text files, py for python, etc.) isn't
assigned to a type. To remedy that,
you can edit the file using:

gksudo gedit /etc/mime.types

Once you've opened the file,
add a new line at the end that
reads:

text/extension extension

Replace the word “extension”
with the extension of the file,
minus the period. As I said earlier,
this shouldn't be a regular
occurrence – if it is, something is
most likely wrong with your
system.

ADD AN ICON TO A MIME
TYPE

If you want to assign a different
icon to a MIME type (adding a
different symbol for python files,
for example), you can do the
following:

• Find a suitable svg file (or make
one)

• Name it text-extension.svg

(replace extension with the
corresponding text from the
mime.types file). Logically, of
course, you can't use slashes in the
file name (otherwise Linux will
assume it's a subdirectory), hence
the hyphen instead. It must also all
be lowercase.

• Copy the file to
/usr/share/icons/gnome/scalable/
mimetypes with

sudo cp text-extension.svg
/usr/share/icons/gnome/scalab
le/mimetypes/

• Log out and back in for changes
to take effect.

For our Python example, the
command would look like this:

sudo cp text-x-python.svg
/usr/share/icons/gnome/scalab
le/mimetypes/

Before I wrap up this article, I
wanted to mention that the
Command-line Cookbook
document I started on Google
Drive (located here:
http://goo.gl/fp09r) has gotten
quite a bit of activity. It's currently
at 2.5 pages of commands. I'm
going to leave it open for editing
for another month, after which I

will begin to put it together. I'm
currently thinking that I'll create a
LaTeX document with the list, and
stick it on github so that we can do
our best to keep it up-to-date, as
opposed to publishing it in a C&C
style article. Let me know if you
have any concerns with this (see
the email address in the next
paragraph). Also, if anyone wants
me to document the process of
creating the LaTeX document as a
tutorial on using LaTeX, I'm more
than happy to do so.

Hopefully this has successfully
answered most questions you had

about assigning new defaults to
files. If you have any questions,
suggestions, or any other kind of
feedback, feel free to email me at
lswest34@gmail.com. If you do
email me, please put 'C&C' or 'FCM'
in the subject line, so it doesn't get
lost.

COMMAND & CONQUER

mailto:lswest34@gmail.com
mailto:lswest34@gmail.com
https://help.ubuntu.com/community/Grub2/Displays
http://goo.gl/fp09r


full circle magazine #75 8 contents ^

HHOOWW--TTOO
Written by Greg Walters PPrrooggrraammmmiinngg IInn PPyytthhoonn -- PPaarrtt 4455

This time, we are going to
rework our database program

from the previous few articles
(parts 41, 42 and 43). Then, over
the next few articles, we will use
QT to create the user interface.

First, let's look at how the
existing application works. Here's a
gross overview:
• Create a connection to the
database – which creates the
database if needed.
• Create a cursor to the database.
• Create the table if it doesn't
exist.
• Assign the video folder(s) to a
variable.
• Walk through the folder(s)
looking for video files.
• Get the filename, seriesname,
season number, episode number.
• Check to see if the episode exists
in the database.
• If it is not there, add it to the
database with a “-1” as the TvRage
ID.
• Then walk through the database
getting show id and status if
needed, and update database.

We will redesign the database

to include another table and
modify the existing data table.
First, we will create our new table
called Series. It will hold all the
information about the tv series we
have on our system. The new table
will include the following fields:
• Pkid
• Series Name
• TvRage Series ID
• Number of seasons
• Start Date
• Ended Flag
• Country of origin
• Status of the series (ended,
current, etc)
• Classification (scripted, "reality",
etc)
• Summary of the series plot
• Genres
• Runtime in minutes
• Network
• Day of the week it airs
• Time of day it airs
• Path to the series

We can use the existing
MakeDataBase routine to create
our new table. Before the existing
code, add the code shown above
right.

The SQL statement (“sql = …”)
should be all on one line, but is
broken out here for ease of your
understanding. We’ll leave the
modification of the existing table
for later.

Now we have to modify our
WalkThePath routine to save the
series name and path into the
series table.

Replace the line that says

sqlquery = 'SELECT
count(pkid) as rowcount from
TvShows where Filename =
"%s";' % fl

with

sqlquery = 'SELECT
count(pkid) as rowcount from
series where seriesName =
"%s";' % showname

This (to refresh your memory)
will check to see if we have already
put the series into the table. Now
find the two lines that say:

sql = 'INSERT INTO TvShows
(Series,RootPath,Filename,Sea
son,Episode,tvrageid) VALUES
(?,?,?,?,?,?)'

cursor.execute(sql,(showname,
root,fl,season,episode,-1))

sql = 'CREATE TABLE IF NOT EXISTS Series (
pkid INTEGER PRIMARY KEY AUTOINCREMENT,
SeriesName TEXT,
SeriesID TEXT,
Seasons TEXT,
StartDate TEXT,
Ended TEXT,
OriginCountry TEXT,
Status TEXT,
Classification TEXT,
Summary TEXT,
Genres TEXT,
Runtime TEXT,
Network TEXT,
AirDay TEXT,
AirTime TEXT,
Path TEXT);'

cursor.execute(sql)
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HOWTO - PYTHON PT45
and replace them with

sql = 'INSERT INTO Series
(SeriesName,Path,SeriesID)
VALUES (?,?,?)'

cursor.execute(sql,(showname,
root,-1))

This will insert the series name
(showname), path to the series,
and a “-1” as the TvRage id. We use
the “-1” as a flag to know that we
need the series information from
TvRage.

Next we will rework the
WalkTheDatabase routine to pull
those series that we don’t have any
information for (SeriesID = -1) and
update that record.

Change the query string from

sqlstring = "SELECT DISTINCT
series FROM TvShows WHERE
tvrageid = -1"

to

sqlstring = "SELECT
pkid,SeriesName FROM Series
WHERE SeriesID = -1"

This will create a result-set that
we can then use to query TvRage
for each series. Now find/replace
the following two lines

seriesname = x[0]

searchname =
string.capwords(x[0]," ")

with

pkid = x[0]

seriesname = x[1]

searchname =
string.capwords(x[1]," ")

We will use the pkID for the
update statement. Next we have
to modify the call to the
UpdateDatabase routine to include
the pkid. Change the line

UpdateDatabase(seriesname,id)

to

UpdateDatabase(seriesname,id,
pkid)

and change the line

GetShowStatus(seriesname,id)

to

GetShowData(seriesname,id,pki
d)

Which will be a new routine we
will create in a moment.

Next, change the definition of
the UpdateDatabase routine from

def
UpdateDatabase(seriesname,id)
:

to

def
UpdateDatabase(seriesname,id,
pkid):

Next, we need to change the
query string from

sqlstring = 'UPDATE tvshows
SET tvrageid = ' + id + '
WHERE series = "' +
seriesname + '"'

to

sqlstring = 'UPDATE Series
SET SeriesID = ' + id + '
WHERE pkID = %d' % pkid

Now we need to create the

GetShowData routine (top). We’ll
grab the information from TvRage
and insert it into the Series table.

Just as a memory refresher, we
are creating an instance of the
TvRage routines and creating a
dictionary that holds the
information on our series. We will
then create variables to hold the
data for updating the table
(above).

Remember that Genres come in
as subelements and contain one or
many genre listings. Luckily when
we coded the TvRage routines, we
created a string that holds all the
genres, no matter how many are
returned, so we can just use the
genre string:

genres = dict['Genres']

def GetShowData(seriesname,id,pkid):
tr = TvRage()
idcursor = connection.cursor()
dict = tr.GetShowInfo(id)

seasons = dict['Seasons']
startdate = dict['StartDate']
ended = dict['Ended']
origincountry = dict['Country']
status = dict['Status']
classification = dict['Classification']
summary = dict['Summary']
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HOWTO - PYTHON PT45
runtime = dict['Runtime']

network = dict['Network']

airday = dict['Airday']

airtime = dict['Airtime']

Finally, we create the query
string to do the update (bottom).
Again, this should all be on one
line, but I’ve broken it up here to
make it easy to understand.

The {number} portion (just to
remind you) is similar to the “%s”
formatting option. This creates our
query string replacing the
{number} with the actual data we
want. Since we’ve already defined
all of these fields as text, we want
to use the double quotes to
enclose the data being added.

And lastly, we write to the

database (below).

That is all for this time. Next
time, we’ll continue as I laid out at
the beginning of the article. Until
next time, Enjoy.

Greg Walters is owner of RainyDay
Solutions, LLC, a consulting company
in Aurora, Colorado, and has been
programming since 1972. He enjoys
cooking, hiking, music, and spending
time with his family. His website is
www.thedesignatedgeek.net.

sqlstring = 'Update Series SET Seasons = "{0}", StartDate = "{1}", Ended = "{2}",
OriginCountry = "{3}", Status = "{4}", Classification = "{5}",
Summary = "{6}", Genres = "{7}", Runtime = "{8}", Network = "{9}",
AirDay = "{10}",AirTime = "{11}"
WHERE pkID ={12}'.format(seasons,startdate,ended,
origincountry,status,classification,summary,
genres,runtime,network,airday,airtime,pkid)

try:
idcursor.execute(sqlstring)

except:
print "Error Adding Series Information"

The Ubuntu Podcast covers all
the latest news and issues facing
Ubuntu Linux users and Free
Software fans in general. The
show appeals to the newest user
and the oldest coder. Our
discussions cover the
development of Ubuntu but
aren’t overly technical. We are
lucky enough to have some
great guests on the show, telling
us first hand about the latest
exciting developments they are
working on, in a way that we can
all understand! We also talk
about the Ubuntu community
and what it gets up to.

The show is presented by
members of the UK’s Ubuntu
Linux community. Because it is
covered by the Ubuntu Code of
Conduct it is suitable for all.

The show is broadcast live every
fortnight on a Tuesday evening
(British time) and is available for
download the following day.

podcast.ubuntu-uk.org

http://www.thedesignatedgeek.net
http://podcast.ubuntu-uk.org/
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When I was a child, I enjoyed
playing with building blocks.

I didn't have the finely finished and
polished blocks like you can buy
for children these days. Instead, I
had wood scraps from my father's
woodworking. I ended up with a
collection of various geometric
shapes and sizes. These blocks
became forts for my toy soldiers,
roadways for my cars, and even a
cityscape complete with airport.
The only limit was my imagination.

While my artistic skills never
advanced much beyond 9th grade
art class, I still enjoy putting things
together and have always enjoyed
geometry. My blocks taught me
that most things can break down
to basic geometric shapes like
circles, rectangles, and other 2D
geometric shapes. With these
objects you can create, even if only
rudimentary, anything.

At the heart of LibreOffice
Draw are these basic geometric
shapes. They allow you to draw
almost anything, and the only
limitation is your imagination. You
will find all the basic objects on the
Drawing toolbar. Starting with the

most basic of all drawing elements,
the line, let's take a look at how to
use the basic objects available to
us in LibreOffice Draw.

LINES AND ARROWS

The line is the second tool on
the default Drawing toolbar, the
first being the selection tool. To
draw a line, click in the drawing
area where you want to start your
line and drag to the end point. If
you look at the status bar while
you draw your line, you will notice
it tells you the size and angle of
your line. To restrict the angle of
your line to increments of 45
degrees (0, 45, 90, 135, 180, -135,
-90, -45), hold down the Shift key
while drawing your line.

Sometimes, you need to draw
your line from a center point
rather than an end point. Hold
down the Alt key while drawing
your line, and the line will grow
outward from the center point.
You can hold down Alt and Shift
together to draw a line from the
center point and restrict the angle
to increments of 45 degrees.

There is also an extended
toolbar for lines on the Drawing
toolbar. It allows you to draw lines
with different arrows and start
points. There is also a line for
showing dimensions. You can use
all the same methods for drawing a
line with arrows that you use to
draw an ordinary line.

Use the line and filling toolbar
to change the line style and
thickness, and to color your line.
Make sure your line is selected
when you make these changes. You
can also select different arrow
styles for your line using the
arrows tool on the Line and Filling
toolbar.

RECTANGLES AND SQUARES

If you wanted, you could use
the snap to grid function and the
Shift key to draw four lines to
create a rectangle or square, but
Draw does provide you with an
easier way to create them. The
rectangle is the fourth tool on the
default Drawing toolbar. With it
you can create rectangles and
squares.

To draw a rectangle, select the
rectangle tool from the toolbar.
Click where you want to place one
corner, and drag to the location of
the opposite corner. You make a
square by holding down the Shift
key while dragging. The shift key
ensures the width and height are
always the same.
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Just like the line, you will
sometimes need to create a
rectangle or square starting from
the center point rather than a
corner. Again, the Alt key causes
the rectangle to expand from the
center. Use the Shift-Alt
combination to draw a square from
the center out.

Rectangles and squares by
default are drawn with the
currently selected line and fill
colors. You can change these using
the Line and Fill toolbar. You can
also use the color bar. Right-click
for line color and left-click for the
fill color. You can also control the
thickness and style of the border
line using the Line and Fill toolbar.

ELLIPSES AND CIRCLES

The ellipse tool is the fifth tool
on the default Drawing toolbar.
Ellipses are drawn much in the
same manner as for rectangles and
squares. Basically, you are drawing
a rectangle which will contain your
ellipse or circle. Just like with the
square, the Shift key lets you draw
a circle. The Alt key is used to draw
your ellipse from the center, and
the Shift-Alt combination lets you
draw a circle from the center.

As with the rectangle and
square, ellipses and circles are
drawn with the currently selected
line and fill colors. You can change
them with the Line and Fill toolbar
or the color bar. The Line and Fill
toolbar also lets you change the
border line style and thickness.

SHAPES AND SYMBOLS

EXTENDED TOOLBARS

Besides the lines extended
toolbar, you have several other
extended toolbars to choose from,
including basic shapes (2D
geometric objects), symbols
(smiley face, moon, heart, etc),
block arrows, flowchart symbols,
callouts, and stars. These extended
toolbars give you a broader set of
objects for building your graphic.

They are drawn in much the

same manner as rectangles,
squares, ellipses, and circles. You
draw a containing rectangle for the
object. The Shift and Alt keys also
work on most objects in the same
way as with rectangles. You can
use the Line and Fill toolbar to
change the line thickness, line
style, line color, and fill color of the
object.

SAMPLE DRAWING – A
SIMPLE ROCKET

As I said in the beginning, I'm
not much of an artist, but I do have
a sense for putting shapes
together to create an object, so
let's walk through creating a very
simple rocket image. Along the
way I will introduce a few new
tools and concepts for working
with basic shapes.

First, we will set up a grid for
our drawing, Tools > Options >
LibreOffice Draw > Grid. Set the
vertical and horizontal resolution
to 1 inch. Set both subdivisions to
10. This will create a nice 1-inch
box grid on our drawing surface.
Check the snap-to-grid. This will
help us get our objects to the right
size.

Let's start with the nose cone.
Select the isosceles triangle tool
from the basic shapes extended
toolbar. Draw the triangle, 2 grid
squares by 2 grid squares, at the
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top of the image. Make the line
color black and the fill color gray
30%. For the body of the rocket,
use a rectangle, 2 grid squares
wide and 6 grid squares tall, line
color black, and fill color gray 30%.

Let's add some stabilizing fins
to our rocket. Select the right
triangle from the basic shapes
extended toolbar. Draw the right
triangle at the bottom right of the
rocket body, 2 grid squares tall and
1 grid square wide. Set the line
color to black and the fill color to
gray 40%. With the newly created
fin selected, Edit > Copy, then Edit
> Paste. The copy will appear over
the top of the first fin. Drag and
drop the copy to the left side of
the rocket body. Right-click the
copy and Flip > Horizontally. Move
it to the lower left of the rocket
body. With the copy still selected,
down-arrow three times to move it
just below the rocket body. Do the
same with the right fin.

We will finish off our drawing
with the engine nozzle. Create an
isosceles triangle at the bottom
center of the rocket body. Use
your best judgment on the size.
The top point of the triangle
should overlap the bottom part of
the rocket body. Make the line

color black and the fill color gray
60%. Make sure the nozzle is
centered at the bottom of the
body. Right-click the triangle and
Arrange > Send to Back. This
pushes the triangle behind the
other objects so we can see only
the bottom part.

There! You have a very simple
drawing.

CONCLUSION

The basic shapes are the
building blocks for images in Draw.
From them, you can create as
simple or as complicated a drawing
as you need for your documents.
You can arrange your objects on
the image to overlap each other
and flip to change the horizontal
or vertical orientation.

In my next How-To, I will show
you how to create arcs, curves, and
polygons in your images.

UBUNTU TOUCH SDK BETA

Today we [Canonical] are announcing the Ubuntu SDK Beta.
The SDK provides a set of APIs that includes the UI toolkit,

enabling developers to create responsive and interactive
applications with a native Ubuntu mobile UI. Qt Creator is an IDE
with a visual interface for writing, testing and deploy applications;
its API documentation and a developer site full of resources and
tutorials make it easy to produce quality applications.

Together with a vibrant and ever-growing community of app
developers, Ubuntu and the SDK provide the best ecosystem for
your apps to thrive.

GET STARTED - GUIDE TO INSTALLING THE SDK

To get started with the Ubuntu SDK, including easy installation
instructions, tutorials and detailed API documentation, visit
developer.ubuntu.com/get-started

To help you design and build beautiful apps, the App Design
Guides include everything you need to know about UX and visual
design best practices. Find them at design.ubuntu.com/apps

You can keep your development phone up-to-date with the
latest build by following the instructions at
wiki.ubuntu.com/TouchInstallProcess

ANNOUNCEMENT FROM CANONICAL

http://developer.ubuntu.com/get-started
http://design.ubuntu.com/apps
http://wiki.ubuntu.com/TouchInstallProcess
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Programs needed:
Ajay Roopkalu's script Tasky:
https://github.com/jrupac/tasky

Google API Client for Python:
https://code.google.com/p/google
-api-python-client/

Kaivalagi's Conky Text script which
is part of his Conky Misc package:
https://launchpad.net/~conky-
companions/+archive/ppa

This howto assumes the reader
is familiar with Conky. How to

set up a working Conky could
easily fill another howto. For
advice on all things Conky, check
out the Conky thread at the
Ubuntu Forums:
http://ubuntuforums.org/showthr
ead.php?t=281865&highlight=conk
y+screen

I use both Google Calendar and
Google Tasks a lot. I schedule all of
my work events as well as personal
events in the calendar and keep a
list of things I need to do in the
tasks.

I prefer the command line over
really big clunky applications. Why?
One, I feel so cool using just a
terminal; two, it seems as though
command-line programs are just a
lot more responsive than some of
the larger programs.

So, after looking around, I
found a lot of information about
using Google Calendar in Linux. I
settled on gcalcli because it gives
me access to the calendar via the
terminal. Once I had that, it was
easy to pipe the calendar into
Conky and have my schedule on my
desktop.

Google Tasks, though, was
another story. There isn't much out
there for Google Tasks, at least not
on the command line. (Maybe, I am
one of the very few who use
Google Tasks?)

Step 1 – Download and install the
Google API Client for Python

Step 2 – Download and make
executable the Tasky script

Step 3 – Go to Google's API
Console -
https://code.google.com/apis/cons
ole/
Step 3B – Create a new project and
switch on the service tasks
Step 3C – Once you fill out your
project name and add your Google
credentials, you should be given a
client ID and a client secret. (You
will need these.) They are listed
under the heading Client ID for
installed applications

Step 4 – Once you have the ID and
secret, launch Tasky. You should be
asked to provide both of those.
You may also need the API key
which can be found under the
heading Key for browser apps
(with referers)

Step 5 – You will see a url in your
terminal and a place to enter a
code. Follow the url and allow
Tasky (the project you just created

at the API Console) access to your
Google account. Once done, you
will see an authorization code.
Copy that code and paste it into
your terminal (Ctrl+Shift+V).

Step 6 – Depending on where you
store the Tasky script, this may not
be necessary. In my case, I have my
script in a scripts folder. The
keys.txt file that was generated
when you granted authorization
will be created in your home. I had
to move the keys.txt file to my
scripts folder in order to avoid
having to authenticate each time I
tried to run Tasky.

ARE YOU STILL WITH ME?

Now, if you type Tasky, or, in my
case, T, because I used a bash alias
to shorten the command, then l
(lower case L), you should see the
tasks on all of your lists.

Since almost all of my tasks
have a due date and a note, I use
this script to streamline adding
tasks:

https://github.com/jrupac/tasky
https://code.google.com/p/google-api-python-client/
https://launchpad.net/~conky-companions/+archive/ppa
http://ubuntuforums.org/showthread.php?t=281865&highlight=conky+screen
https://code.google.com/apis/console/
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I put the date format reminder
in because I always want to write
DD/MM/YY, but don't know
enough python to change the
Tasky script. (I did try a search and
replace and succeeded in breaking
the script.)

Of course if you don't want a
date or a note you can edit the
script by either taking those lines
out or writing an if-then
statement. (I don't actually know
how to write that if-then
statement, but I'm sure it can be
done.)

Now to put it into Conky so that
it shows up on the desktop: Install
Kaivalagi's Conky Misc package

You could pipe the list of tasks
into Conky as it is, but that would
look pretty ugly. The cool thing
about Kaivalagi's Conky Text script
is that it supports templates.

Below is the template I use for
my Tasks Conky:

${font Ubuntu:size=10}${color
6892C6};${color red};${color
yellow};${color green}

To get my task list into a format
that matches that template. I
wrote a sed command and put it in
a script (bottom).

I have a cron job set to run this
script every ten minutes.

I call the cleaned text file from
Conky with:

${execpi 600 conkyText
–textfile=/home/grouchygaijin
/scripts/Text-
Conky/tasks2.txt

--
template=/home/grouchygaijin/
scripts/Text-
Conky/task.template}

There you have it. Google Tasks
on your desktop in a visually
pleasing manner, and it didn't cost
a thing. I say that because one
option I did see for Linux online
wanted 12.95 USD for their skin-
able program that will, among
other things, display your tasks on
your desktop.

John grew up in the United States,
but has been living in Sweden since
2009. He has been using Ubuntu
since 2008. John's other interest is
music. You can visit his music site at
www.grouchygaijin.com

#!/bin/bash
echo "This adds a task WITH a due date AND a NOTE."
read -p Subject: sub
read -p "Due Date(MM/DD/YY):" ddate
read -p "Note:" note

~/scripts/tasky a "$sub" -d "$ddate" -n "$note"

#!/bin/bash
/home/grouchygaijin/scripts/tasky l > ~/scripts/Text-Conky/tasks.txt
cat ~/scripts/Text-Conky/tasks.txt | sed -e '1d' | sed -e 's/Notes:/Notes ;;Notes;:/' | sed -e 's/^ *[^ ]* //' | sed -e
's/Date:/;Due Date:/' > ~/scripts/Text-Conky/tasks2.txt

http://www.kame.net
http://www.test-ipv6.com
http://www.ipv6-test.com
http://www.grouchygaijin.com
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Don't worry Blender fans. Nicholas
will be back next month. His
excuse this month was something
about getting married.

This month we’ll look at
restoring old and damaged

photographs using GIMP. For this
example I’m going to use a photo
of my late grandfather as a child.

It’s a very old photo taken in
the early 1900’s so the dark and
light colors aren’t as pronounced
as they could be, but even fixing
that won’t repair the damage, but

GIMP will. Once we have the photo
restored we can do some basic
color correction to it.

THE CLONE TOOL

In the tool box, choose
the Clone Tool icon
(shown left). What this

does is let you select a source
within the image which it will clone
to wherever you paint. Let’s start
easy and go with the crack to the
left of his head. There are no
details in/behind it, so it should be
easy to repair. Here’s the steps I
take to repair it:

I select the clone tool then a
suitable sized brush (with a soft
edge) which has a diameter larger
than the width of the crack. You’ll
notice that the pointer has a
stamper icon beside it and a no
entry icon. This is because I have
not chosen a source yet, so the
tool is not ready to use at the
moment.

To choose a source, I hold down
CTRL and left-click above the crack
at the point where I want to start

from. Please note: the source you
choose has to match where you’re
going to clone it. If I chose a source
above the middle of this crack then
go from left to right it would not
match.

With the source chosen I now

hold down the left mouse button
and draw over the crack in one
motion. If I stop-start, it will reset
the source and not match where I
am in the motion.

And that is the magic of the
clone tool. You follow that
procedure for each crack or
blemish on the photo. The tricky
part arises when you get to things
like the vertical bar in the window
backdrop; it must match, and it will
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take a few tries before you get it;
the source will need to be
above/below where you’re
painting.

It’ll take a bit of practice, but
you’ll get there in the end. Middle
right what I have after a few
minutes of Clone Tool action.

After I’ve removed all the cracks
I apply some basic color correction
(shown bottom right).

Obviously you remove all the
blemishes then do your color
correction, but I just wanted to
give you a brief introduction to the
power of the clone tool.

PYTHON SPECIAL EDITIONS:

http://fullcirclemagazine.org/issue-py01/ http://fullcirclemagazine.org/issue-py02/

http://fullcirclemagazine.org/python-
special-edition-issue-three/

http://fullcirclemagazine.org/python-
special-edition-volume-four/

http://fullcirclemagazine.org/python-
special-edition-volume-five/

http://fullcirclemagazine.org/python-
special-edition-volume-six/

http://fullcirclemagazine.org/issue-py01/
http://fullcirclemagazine.org/issue-py02/
http://fullcirclemagazine.org/python-special-edition-issue-three/
http://fullcirclemagazine.org/python-special-edition-volume-four/
http://fullcirclemagazine.org/python-special-edition-volume-five/
http://fullcirclemagazine.org/python-special-edition-volume-six/
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Although Inkscape is a vector
graphics program, it does

have some support for including
bitmap images in your drawings.
It's certainly not a fully fledged
bitmap editor, and neither is it a
desktop publishing program. If you
want to airbrush a photo, you
would be better off using The
GIMP, and if you want to lay out a
newsletter, then Scribus would be
a better tool.

Getting an image into Inkscape
is quite simple. My preference is to
drag-and-drop it from the desktop
or file manager into the main
Inkscape window. Alternatively,
you can use File > Import to pull
your picture into an open
document. File > Open will also do
the job, but that will create a new
Inkscape document with just the
image in, and the document's page

size set to the dimensions of the
image. Whichever approach you
take, you will next be presented
with an import dialog (left)).

If you select “Embed” then the
image will be included as part of
the Inkscape file. For the
technically minded it is Base64
encoded, which is a means of
representing binary data using
text. Unfortunately, this encoding
has been designed for robustness
rather than efficiency, so will
inflate the storage space required
for your bitmap by about a third.
The advantage, however, is that an
embedded image is part of the
SVG file, so if you move the
document to another location, or
even another machine, the bitmap
will move with it.

Selecting “Link” will include the
location of your bitmap in the SVG
file, but not the data that makes
up the image itself. If you
subsequently move the SVG file,
you'll need to move the bitmap
with it, or fix the link to account
for the change in location. One
advantage of linking a file is that, if

you make changes to the original
bitmap image, those changes will
be automatically reflected in the
Inkscape document. For an
embedded bitmap you would have
to remove the current version
from the document and then
embed the modified version.

Which option to choose
depends on what you are doing
with the bitmap in your Inkscape
drawing. If it's only there
temporarily—so that you can trace
over it, or use it for
reference—then linking is
probably the best option. For use
as a permanent part of your
design, then embedding might be
better – especially if you plan to
move the Inkscape file, put it on a
web server, or send it to someone
else. If you're unsure, then I would
suggest linking the image; you can
always embed it later using the
Extensions > Images > Embed
Images... menu option.

Checking the “Don't ask again”
box will mean that future imports
will default to your choice of
Embed or Link. I prefer to leave

this unchecked, as I tend to switch
between the two options
depending on what I'm drawing. If
you do check this and then
subsequently change your mind
you can switch to the other option,
or tell Inkscape to ask in future, via
File > Inkscape Preferences... then
selecting the Bitmap section and
changing the “Bitmap import”
option.

Having imported an image, it
will appear in Inkscape with the
normal selection handles. One
thing that might surprise you is the
size of the image—imported
bitmaps tend to be bigger than
you might expect. This is because
Inkscape imports them at a
resolution of 90dpi, regardless of
the size, shape or embedded
metadata of the image. At this
resolution, a 900 pixel tall image
will be 10 inches tall, nearly filling
an A4 page.

Within Inkscape, it might be
useful to think of your picture as
being a group of colored
squares—albeit a group that you
can't enter or un-group. Each
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square is drawn at 1/90 of an inch
in size, but you can scale it up or
down using the selection handles,
just as you would with any other
object. Scaling like this doesn't
change the number of rectangles
in the group, it just changes the
size and shape of each one. You
can also skew and rotate the
image, or change its opacity, just
as you would with any other group
of rectangles. Here's an example
of an image made up of only 25
pixels, but copied, scaled and
transformed to fill an A4 page. You
can see that talking in terms of
pixels and dpi quickly stops making
sense when you've transformed
your pixels into rotated
rhomboids!

Sometimes, you don't want the

whole of a bitmap image in your
drawing. If your image is a PNG
file, then Inkscape will honor any

transparency that's present. This
can be used to include non-
rectangular elements into your
drawing. Take the Full Circle
Magazine logo as an example: you
can clearly see the difference
between using importing a JPEG
version, which doesn't support
transparency, compared with a
PNG version, which does.

When protecting sensitive
readers from the fleshy expanses
of renaissance art, for example, a
pair of PNGs makes for a
reasonable brassiere, whereas
JPEGs lead to overly obtrusive
underpants...

Another way to show just a sub-
section of an image is to use
clipping. This works in exactly the
same way as clipping any other
object—just draw a clip path on
top, select both the path and the
image, and then choose Set Clip
from the context menu, or Object
> Clip > Set from the main menu.
Using this with the bottom left
corner of our renaissance painting,
followed by some rotating and
flipping, leads to an image that
should be
familiar to
anyone who has
seen Monty
Python's Flying
Circus.

The hard
edges of a clipped image don't suit
every requirement, but, as you
might expect, masking also works.
A simple blurred shape with a
white fill, used as a mask, lets you
feather the edges of a bitmap
image for a softer effect.

As you may recall from the
previous part of this tutorial,
masks are just collections of
colored pixels—just like bitmap
images. Inkscape will happily let
you use an imported bitmap as a
mask—it's really no different to
using a group of rectangles. On
first impressions it looks as though
using an image as a mask results in
something like a photographic
negative:

What you're actually seeing is
the white of the Inkscape canvas
showing through the darker parts
of the image, and the color of the
masked object appearing where
there are lighter parts in the
image. By changing the masked
object to a lighter color, and using
a dark object as the background,
relative normality is restored:



full circle magazine #75 20 contents ^

Mark's Inkscape created webcomic,
'Monsters, Inked' is now available to
buy as a book from
http://www.peppertop.com/shop/

HOWTO - INKSCAPE Pt15

It's worth noting that you can
mask any sort of object. The
examples here all use an image to
mask a single rectangle with a flat
fill color, but you can use the same
technique on an object with a
gradient or pattern fill, or even on
a group of objects.

Depending on your source
image, you may find that you get
better results if you convert it to a
grayscale using a bitmap editor
such as The GIMP. A bitmap editor
will also give you the opportunity
to lighten, or darken, or even
invert, the colors of the image. If
the image was included in Inkscape
as a Link rather than an Embed, the
effect of your changes will be
applied to your Inkscape drawing
each time you save the bitmap
image in your editor, allowing you
to easily experiment with different
changes to the bitmap. In my
experience Inkscape isn't always
perfect at refreshing the screen
when the bitmap changes, but
scrolling the canvas a little, or
changing the zoom level, usually
fixes the issue.

Using bitmaps as masks can be
another way to get around the
limited types of gradients that the

SVG format supports. For example,
by creating a conical gradient in
The GIMP, then using it to mask a
yellow square on a green
background, it's possible to
produce a conical yellow-green
gradient that would be difficult to
create in Inkscape alone.

Of course this approach doesn't
result in a genuine vector gradient,
so the accuracy is determined by
the resolution of your bitmap. You
could get the same effect by
simply creating a yellow-green
conical gradient directly in The
GIMP, and then importing it
directly into Inkscape. By using the
image as a mask, however, you can
still freely change the colors within
Inkscape, rather than having to
modify the bitmap image each
time.

A major limitation of this
method is that you can affect the
transparency of only one object at
a time, so gradients with multiple
color stops are a problem. You can

work around this by using your
mask on a group of objects, or by
layering several masked objects on
top of each other, but that can
quickly become complex. To
demonstrate this approach, I've
created a bitmap using the “Three
Bars sin” gradient from The GIMP,
drawn as a spiral gradient. I first
applied this to the same yellow
square on a green background as
used previously, then duplicated it
in-place (Edit > Duplicate, or Ctrl-D)
before rotating it slightly to give a
multi-colored spiral gradient.

As you can see, once a bitmap
has been linked or embedded into
an Inkscape document, you can
pretty much treat it in the same
manner as any other object. If you
think of it simply as a group of
colored rectangles then you won't
go far wrong. Don't mistake
Inkscape for a bitmap editor or a
desktop publishing program,
though—The GIMP or Scribus are
far better tools for those tasks.

Next time, we'll continue our
tour of bitmaps in Inkscape by
finding out how to turn them into
genuine vectors.

Image Credits

“Venus, Cupid, Folly and Time” by
Angelo Bronzino
http://commons.wikimedia.org/wik
i/File:Angelo_Bronzino_001.jpg

“La Gioconda” (aka “Mona Lisa”) by
Leonardo da Vinci
http://en.wikipedia.org/wiki/File:M
ona_Lisa,_by_Leonardo_da_Vinci,_f
rom_C2RMF_retouched.jpg

http://commons.wikimedia.org/wiki/File:Angelo_Bronzino_001.jpg
http://en.wikipedia.org/wiki/File:Mona_Lisa,_by_Leonardo_da_Vinci,_from_C2RMF_retouched.jpg
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HHOOWW--TTOO
Written by Ronnie Tucker WWrriittee FFoorr FFuullll CCiirrccllee MMaaggaazziinnee

GUIDELINES

The single rule for an article is
that it must somehow be

linked to Ubuntu or one of the
many derivatives of Ubuntu
(Kubuntu, Xubuntu, Lubuntu, etc).

RULES

• There is no word limit for articles,
but be advised that long articles
may be split across several issues.

• For advice, please refer to the
Official Full Circle Style Guide:
http://url.fullcirclemagazine.org/7
5d471

• Write your article in whichever
software you choose, I would
recommend LibreOffice, but most
importantly - PLEASE SPELL AND
GRAMMAR CHECK IT!

• In your article, please indicate
where you would like a particular
image to be placed by indicating
the image name in a new
paragraph or by embedding the
image in the ODT (Open Office)

document.

• Images should be JPG, no wider
than 800 pixels, and use low
compression.

• Do not use tables or any type of
bold or italic formatting.

If you are writing a review,
please follow these guidelines :

When you are ready to submit
your article please email it to:
articles@fullcirclemagazine.org

TRANSLATIONS

If you would like to translate
Full Circle into your native
language please send an email to
ronnie@fullcirclemagazine.org and
we will either put you in touch with
an existing team, or give you
access to the raw text to translate
from. With a completed PDF, you
will be able to upload your file to
the main Full Circle site.

REVIEWS

GAMES/APPLICATIONS
When reviewing games/applications please state clearly:

• title of the game
• who makes the game
• is it free, or a paid download?
• where to get it from (give download/homepage URL)
• is it Linux native, or did you use Wine?
• your marks out of five
• a summary with positive and negative points

HARDWARE
When reviewing hardware please state clearly:

• make and model of the hardware
• what category would you put this hardware into?
• any glitches that you may have had while using the hardware?
• easy to get the hardware working in Linux?
• did you have to use Windows drivers?
• marks out of five
• a summary with positive and negative points

You don't need to be an expert to write an
article - write about the games, applications
and hardware that you use every day.

http://url.fullcirclemagazine.org/75d471
mailto:articles@fullcirclemagazine.org
mailto:ronnie@fullcirclemagazine.org
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https://spideroak.com

Get 25% off any SpiderOak package
with the code: FullcirclemagFans

https://spideroak.com
https://spideroak.com
https://spideroak.com/mobile
https://spideroak.com
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AASSKK TTHHEE NNEEWW GGUUYY
Written by Copil Yáňez

If you have a simple question, and
“Ubuntu Touch” sounds like what

happens when you get too close to
Mark Shuttleworth, contact me at
copil.yanez@gmail.com.

Today’s question is:
Q: With Ubuntu improving at such
a heady pace, is Linux gaming
keeping up?

A: Yes. And to explain why I think
so, let’s go back a bit. Say, a few
millenia.

For tens of thousands of years,
humans survived as hunter-
gatherers, living a precarious
existence balanced on the knife-
edge between having just enough
food to live and becoming the
protein layer in a saber-toothed
tiger’s australopithecine sandwich.

But then someone was all, hey,
what the hell? There’s a perfectly
good cave over there. It’s
protected from the elements, has
great airflow and valley views, and
once we clear out the ten
thousand bats living inside and
sweep up a century of

accumulated guano, it would make
a great little walkup with easy
watering hole access. It’s got curb
appeal! Let’s live there.

Thus was the cradle of
civilization gentrified. And with
gentrification came comfort. And
with comfort came a desperate
need to fill all those hours we used
to spend hunting and gathering.

Modern video games are the
inevitable outcome. Gaming is the
sort of leisure activity that signals
a transition from
hunting/gathering to shabby-chic
cave living.

If Linux appears to be leading
from the rear with regards to
gaming, it’s because Linux users
didn’t always have as much time as
their Windows-user counterparts. I
mean, come on, Windows users
had all sorts of time, hours upon
hours of down-time they needed to
fill. Pretty sure the Lascaux cave
paintings were the work of an early
Windows admin who drew them
while waiting for a spinning
hourglass to resolve.

Before my teasing goes too far,
I have a confession: I’m a Windows
gamer. I would sooner give up my
own kidney than get rid of my
50th-level female Nord character
in Skyrim. Her name is Sheila and
she’s getting married to Lydia, her
faithful companion. I like Skyrim
because, in addition to wielding a
two-handed battle sword and
killing lizard-men, I get to live in an
idealized world of progressive
social politics where no one bats
an eyelash when two females get
married. It’s like Massachusetts.
With dragons.

Knowledgeable users will point
out that I can play Skyrim on
Ubuntu using WINE or
PlayOnLinux, Windows emulators
that allow you to run Windows
programs on your Linux machine.
They might also suggest I run a
virtual machine, basically a walled
off part of my computer where
Windows can run free like a panda
at the zoo.

But none of these solutions are
for the faint of heart or, like me,
the stupid of brain. They require

tweaking user settings,
downloading Internet Explorer,
and, oooh, look, something shiny
just distracted me because I’m SO
BORED.

For Linux gaming to be
competitive, it’s got to “just work.”

I’m going to argue that Linux
gaming has arrived. At the very
least it’s putting its tray table and
seat back in the upright, locked
position. Users like me can now
download games from trusted
sources and rely on the game to
automagically adjust itself to
optimal playable settings. I can
start playing without looking up a
single dependency or rolling back a
single browser or glorping a single
foopsiwitz.

I came to this realization after a
recent gaming bender where I
went eighteen hours without food
or sleep just so I could hand forge
a silver wedding band for Lydia. In
a matrimonial haze, full of love and
tolerance, I thought I might have
another look at Linux gaming.

mailto:copil.yanez@gmail.com
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The last time I did this, Valve
had just announced its Steam
video game distribution platform
for Linux. And the Ubuntu
Software Center seemed to be
featuring slick-looking video
games on its front page more
often. I knew there were lots of
games to play.

But what was the experience
really like? I went looking for some
free games to answer this
question. I found three good
candidates, all free or free-to-play
(meaning, you can play the game,
but advancement will eventually
cost you something). Let’s take a
look.

The first two required the
Steam client for Linux, available at
http://store.steampowered.com/.

Steam isn’t a game itself. It’s
software that allows you to
download, play and backup games.
It works on Mac, Windows and
Linux (although not all games play
on all platforms). There are lots
and lots of games available on
Steam for Linux, some of them
familiar titles from other platforms
(like Left 4 Dead 2 and Counter
Strike).

The cool thing about Steam is
that if the game says it plays on
Linux (and your machine meets the
minimum specs), it pretty much
will. What’s more, if you download
a game and later reformat your
hard drive or acquire another
computer, you simply load your
Steam profile and re-download
your games.

Probably the best thing about
Steam gaming on Linux is that it
automatically adjusts the game
settings to match your PC’s specs.
So if you’re rocking a multi-core
processor with discrete graphics
card, the game will start with
higher settings. If you’re using a
slower machine, you may not get
all the eye candy, but you’ll still be
able to play. This is important for
Ubuntu users because many of us
turned to the OS because it keeps
us from joining the “arms race,” the
desperate competition to own the
most powerful computer on the
block.

Once you set up your Steam
profile, downloading a game is a
point-and-click affair. It will cost
you money to play most games but
older titles are cheap or free, and
there are usually demos available.

I downloaded two games from
the Steam Store, both free.

TEAM FORTRESS 2
Steam

Team Fortress 2 will be familiar
to anyone who’s played Unreal
Tournament. Or, you know, Team
Fortress 2 on another platform.
Basically, it’s teams of mercenaries
on a strange planet fighting for
control of a map. Or something.
Whatever, it’s a bunch of people
fragging each other with plasma
guns and rocket propelled
grenades. This game has an online
component that allows you to play
with anonymous players on a
server or set up your own game

that only you and your friends can
access.

TF2 has been around since
2007. I mean, that was before
Twitter, man! As such, the
likelihood of the game looking
dated is very high. So I was
surprised at how well the graphics
have held up. Seriously, unless you
think every game should be as
photorealistic as Skyrim, the
gameplay and look of TF2 won’t
leave you wanting for anything.

Probably the biggest surprise
for me was how fast the game
played. I am running Ubuntu 13.04
on a three-year-old AMD-based
machine. It’s got a separate video

ASK THE NEW GUY

http://shop.canonical.com/index.php?cPath=17
http://www.ubuntu.com/download/alternative-downloads
http://store.steampowered.com/
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card, so I didn’t expect the
graphics to move like molasses on
a cold day. But I also didn’t expect
the stutter-free gameplay I
experienced. And I didn’t need to
tweak anything myself to get it.
Steam automatically detected my
setup and prepared the game for
optimal play. Nice.

I had fun running around,
blasting people with my gatling
gun, and watching as my limbs flew
apart whenever I was killed by
another player. If you’re into team-
based first-person-shooters, check
it out.

Team Fortress 2 Verdict: 8
Severed Limbs out of 10

AMNESIA: THE DARK

DESCENT
Steam

Amnesia is a creepy horror
game where you run around a dark
castle, looking behind closed doors
and basically acting like every
horror movie victim you’ve ever
seen. Hear that noise over there
that sounds like the crusty nails of
a long-dead woman? Yeah, let’s go
look there. I just needed someone

behind me yelling, “Call the police,
you moron, there’s a murderer
behind that door!”

Amnesia came out in 2010 and
there’s a sequel in the works. The
atmosphere is dark and the sound
design is great. You’re never quite
sure what’s around the next corner
but looking is half the fun. The
game even recommends you play it
in a dark room with headphones
on. I’m not sure I’m brave enough
to try that, but I can see the
appeal.

Again, the smooth gameplay
and effortless set up was a
pleasant surprise. This is why I say
that we’re really getting
somewhere with Linux gaming.
Never underestimate the power of,

“It just works!”

If you enjoy scary movies, check
out the demo for Amnesia: The
Dark Descent.

Amnesia: The Dark Descent
Verdict: 7 Unholy Phantasms out
of 10

For the final gaming test, I tried
something from the Ubuntu
Software Center. We all know how
easy the USC is. It lists all the titles
from trusted sources, offers free
and paid software, and pulls in all
the bits and pieces you need to run
the software of your choice,
without any effort on your part.

Is the Ubuntu Software Center
the open source counterpart to

Steam?

VENDETTA ONLINE
Ubuntu Software Center

My dream has always been to
get a job as a planet-hopping space
hippie. I’d bring my laser-lute and
photon-harp, and jam with all the
other smelly long hairs from
around the galaxy. So, pretty much
my life ported to an online game.

VO is a MMORPG, a Massively
Multiplayer Online Role-Playing
Game, set in space. You get to
build a spaceship and fly around
blasting enemies and acquiring
resources, which you then use to
upgrade your ship and weapons.

ASK THE NEW GUY

https://help.ubuntu.com/community/BootFromCD
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Copil is an Aztec name that roughly
translates to “you need my heart for
what again?” His love of women’s
shoes is chronicled at
yaconfidential.blogspot.com. You
can also watch him embarrass
himself on Twitter (@copil).

Rinse and repeat.

This game was originally
released back in 2002, when
dinosaurs still roamed the earth.
Or at least AOL did, anyway. This
might explain the rudimentary
graphics.

But, once again, gameplay
trumps just about everything else.
Within a few minutes of loading
the game and choosing my ship
class, I was floating among
asteroids, shooting at roving
enemy ships and docking at space
ports. All I needed was my laser-
lute and I was good to go!

And the gameplay was super
fast and stutter-free. Again, much
of this has to do with the simpler
game engine. But the fact that I
can do this with an older computer,
for free, without having to look up
any tricks or tweaks to get it
working, is pretty cool.

Vendetta Online Verdict: 6 Warp
Drives out of 10

Three great games with
absolutely no hassle to get
running.

I honestly believe we’ve turned

a corner with Linux gaming. The
Steam/Ubuntu Software Center
model should work well for more
complicated games (*cough*
Skyrim *cough*). Those who need
all the fancy graphics can shell out
their hard earned cash for faster
computers.

Those of us who just need a
peaceful brook overlooking a quiet
valley where we can have a
romantic picnic with our life-
partner (and the occasional dragon
sighting) can play, too.

With such radical advancements
in gaming, can there be any doubt
that fragging cartoon avatars using
face-melting pulse guns represents
the peak of human evolution?

The answer is no, there cannot.

Good luck and happy
Ubuntuing!

ASK THE NEW GUY

LIBREOFFICE SPECIAL EDITIONS:

http://fullcirclemagazine.org/libreoffice-
special-edition-volume-one/

http://fullcirclemagazine.org/libreoffice-
special-edition-volume-two/

OTHER SPECIAL EDITIONS:

hhttp://fullcirclemagazine.org/scribus-
special-edition/

http://fullcirclemagazine.org/ubuntu-
development-special-edition/

http://fullcirclemagazine.org/virtualisat
ion-series-special-edition/

http://yaconfidential.blogspot.com
http://fullcirclemagazine.org/libreoffice-special-edition-volume-one/
http://fullcirclemagazine.org/libreoffice-special-edition-volume-two/
http://fullcirclemagazine.org/scribus-special-edition/
http://fullcirclemagazine.org/ubuntu-development-special-edition/
http://fullcirclemagazine.org/virtualisation-series-special-edition/
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LLIINNUUXX LLAABB
Written by Charles McColm NNeettggeeaarr NN330000 WWiirreelleessss RRoouutteerr

Over the past couple of
months I noticed our Internet

connection appeared to be slowing
down. Network games were okay,
but downloads trudged along at
around 100 kb/s, and our tablets
and phones were having great
difficulty watching streaming
video. After a bit of help from our
ISP, I narrowed the problem down
to our router.

Having just returned from
holiday, our budget was limited to
under $100. In the past I’ve owned
routers by Netgear, Linksys, and D-
Link, and, while our Linksys router
served us well for a couple of
years, our Netgear also worked
very well. There were 10 routers
that fit in that range up for
consideration. Of those routers I
excluded the D-Link routers
because the couple I’ve owned in
the past both ended up dropping
wireless connections frequently
after only a few months of use. Of
the remaining routers, only the
routers priced around $100 had
gigabit ports, and, since we already
have a gigabit switch, I eliminated
them. To judge the remaining

routers, I went online and looked
at consumer ratings on several
different sites. The router I chose,
the Netgear N300, was also the
second least expensive at $39.
While this wasn’t a primary
concern, it was a nice bonus.

Netgear makes at least a couple
of routers under the banner N300
– the WNR2000 and the
WNR3500L. The WNR3500L is a
reasonably priced gigabit router
sold on Amazon for $60. This
article covers the WNR2000 – a
non-gigabit wireless N router. Had
my local store carried the Amazon
N300 router, I might have bought
it, but I needed a router quickly.

Opening the box I was surprised
the first thing I saw was a printed
copy of GPLv3 and GPLv2 license.
This really isn’t that surprising this
day and age since a lot of routers
use some form of *NIX. The box
came with a power cable, the
WNR2000v3 router, and a short
yellow ethernet cable.

Configuration turned out to be
a bit of a pain, the router’s “genie”
software mis-detected our
connection as a PPTP connection
rather than a PPPoE connection.
Having owned a couple of Netgear
routers before, I knew they tend to
use 10.0.0.1 instead of 192.168.0.1
as an address. Opening a terminal
and typing ifconfig confirmed the
router had assigned my notebook
an address in the 10.0.0.x range. I
corrected the router setup by
going to the Basic > Internet tab,

selecting PPPoE from the Internet
Service provider tab, and then
entering my details.

The router interface is clean,
but somewhat unresponsive, likely
due to Netgear’s “genie-ing” the
web interface. According to this
article on the OpenWRT website
http://wiki.openwrt.org/toh/netge
ar/wnr2000, version 3 of the
WNR2000 runs OpenWRT (version
1 and 2 do not). If this is true,
Netgear has gussied it up to look
like something else and stuck the
genie moniker on it.

As I mentioned earlier the
WNR2000 is a wireless N router, it
bonds a couple of channels
together to attain a theoretical
maximum of 300 Mbps. The first
real test was streaming video to
our family tablet. I didn’t hear any
of the usual complaints about
Internet speed from family, so the
WNR2000 appeared to have at
least fixed that problem.

Netgear also provides a free
genie app for iOS and Android
devices. I tried the genie app on

http://wiki.openwrt.org/toh/netgear/wnr2000


full circle magazine #75 28 contents ^

LINUX LAB
our tablet but was unsuccessful
logging in to our router using the
password I created or the default
“password” password suggested
by the app. Oddly enough, the My
Media section of the genie app did
work – allowing us to stream video
from our XBMC machine to our
tablet. If you own an iPad, you’ll
appreciate this feature since, in my
experience, most of the iOS upnp
applications are crippled until
purchase. Sadly, all of the genie
apps except the upnp media app,
and the QR barcode reader on the
page after, wouldn’t work without
logging in to the router.

As expected, the BASIC tab of
the router is a really dumbed down
interface that doesn’t allow a lot of
control. The ADVANCED tab
contains more of the options you’d
expect on a router, Internet setup,
wireless setup, LAN setup, Quality
of Service rules, parental controls,
site blocking, and more. One of the
features I look for is the ability to
set up DHCP reservations based on
MAC address, a feature under the
Advanced > Setup > LAN setup
section.

The Advanced > Advanced
Setup > Wireless Settings let you
turn on and off the internal

wireless antenna both completely
and by schedule, and create a
wireless access list. The WNR2000
can also act as a wireless access
point. This feature lets you run a
cable from the standard ethernet
port on a router to the WAN port
on a WNR2000 and use it as the
access point. The WNR2000 can
also act as a wireless repeater,
effectively boosting the wireless
signal in a different room.

Port forwarding and triggering
are also supported under the
Advanced Setup section. I’ve used
port forwarding in the past to
open up ports and allow traffic to
come through for a game server I
ran.

Universal Plug and Play, UPnP, is
enabled on a lot of routers by

default, I turned it off on the
WNR2000v3. Having UPnP enabled
is just begging to be hacked, and
judging by the number of DoS
attacks on high ports – 15 (one of
which appears to be legitimate
traffic) in 1 day, it’s a good thing I
turned it off. Disabling UPnP does
not prevent upnp devices on the
local LAN from functioning
correctly. Our iPad and Android
phones were all able to correctly
connect and stream to and from
our XBMC media center with UPnP
disabled on the router (this may
have been why the iPad genie app
refused to log in correctly, but I’d
rather be safe and not use them
than deal with a hacked server).

As I’ve hinted above, the
WNR2000v3 keeps some logs.
There isn’t a fancy graph of traffic

like on the tomato-hacked Linksys
router we used to own, but you can
set up the WNR2000v3 to send out
email notifications of the logs, a
handy feature to have if you’re
away and want to monitor your
router from your phone.

Netgear makes several routers
in the N*series, the top end using
the new 802.11ac standard which
operates on the less busy 5GHz
band (the WNR2000v3 operates on
the 2.4GHz band). At the higher
end, the routers claim larger
wireless coverage, better video
streaming, and signal interference
avoidance. With over 60 wireless
signals available nearby, our N300
(WNR2000v3 model) has been
performing well - though we’re
covering only roughly 1000 square
feet. The N300 isn’t the most
feature-rich router on the market,
but it’s a sight better than other
routers I’ve tried, and at about half
the cost of routers that have failed
on us.

Charles is a step-father, husband,
and Linux fan, who hosts a not-for-
profit computer refurbishing
project. He maintains a blog at:
http://www.charlesmccolm.com/

http://www.charlesmccolm.com/
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MMYY SSTTOORRYY

I started with Ubuntu in 2005 on
“Breezy Badger” 5.10. Until then,

my wife and I had shared a home
computer, but, when we bought a
new computer, I decided to extend
my horizons a bit and experiment
on the old one. I had been exposed
to SuSe at work but now I had read
a bit about this new distribution of
Linux called Ubuntu, and, being a
good South African, was as much
attracted by the name “Ubuntu” as
by the idea of running Linux.

So I asked for the free disks
from Canonical and installed them
on the old computer, and have
been hooked on Ubuntu Linux ever
since. I have tried every version of
Ubuntu, but, since 2010, I have
stuck to the Long Term Support
releases for my main machine and
have loaded the intermediate
releases on a test machine (which
was originally the machine that I
first used for Ubuntu until I bought
yet another new new machine last
year and they all moved down a
rank).

Why do I love Ubuntu? The
reasons are long, and complex, and

not always logical. But, first of all, I
buy in completely with the concept
of Open Source software. I started
in computers in 1966 as an
assembly language programmer
working on operating systems
maintenance (and later, operating
systems development), and in
those days it was impossible to
even conceive of the idea of not
having access to the source code of
all systems software. Then, slowly,
software became big business, and
source code became hidden from
the customer. (I sometimes
secretly wonder if that is not
because the code is of such a low
standard that the software
companies are ashamed of it). It is
not that I want to change the
software; it is that I – illogically –
want to know that I can if I want to!

And then, I don't like paying a
lot of money for stuff that I don't
use very often, and I don't like
piracy. At the moment, Microsoft
charges over R2000 for a copy of
Microsoft Office. That is insane
when LibreOffice costs nothing.
Using Ubuntu, I have access to a
whole world of free software that

covers nearly everything that I can
possibly want to do with my
computer. Best of all, I can try
something, and, if it doesn't meet
my requirements, I can throw it
away at no cost except the time
that I have used for the
experiment.

I seem to have so much more
control over what happens in
Ubuntu than I ever had using
Windows. (Actually, I still help lots
of people with their Windows
machines and am constantly
annoyed when the system wants to
do things its way rather than my
way).

But I think that what I really
love about Ubuntu is that the user
community is so enthusiastic about
helping people with their
problems. Ask any question from
the experts and, instead of being
told to try Google, there will be
three or four responses. I have
never had a problem which the
community has not been very
helpful in trying to solve. (And,
let's face it, some of my problems
have been pretty infantile!)

The only problem that I have
not been able to solve or work
around is that I never managed to
get my old Canon laser printer to
work on Ubuntu. I am biased
enough to think that this is Canon's
fault and not Ubuntu's.

I switched to the Unity interface
with 12.04 and like it a lot. I do
have the problem, though, that
Gimp does not run well under
Unity, and so, being a heavy Gimp
user, I have been forced to run
Xubuntu as well as Ubuntu, and
now I run both Xfce and Unity. Not
really a problem, but I wish that
the problem would get solved so
that I could settle on a single
interface.

I live in a large retirement
resort in the South African country.
I must confess that my attempts at
evangelising Ubuntu have not been
too successful. I have been much
more successful in promoting the
concept of Open Source software.
(If anyone has a problem with
Word, I immediately install
LibreOffice for them!) Slowly,
slowly ...

Written by Bill Cairns
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Full Circle Podcast
Episode 34,
Raspberry
Jamboree 2013

Your hosts:
• Les Pounder
• Tony Hughes
• Jon Chamberlain
• Oliver Clark
and Freaky Clown

from the Blackpool (UK) LUG
http://blackpool.lug.org.uk

Welcome to the first of a 2
part conference special, in
this episode the presenters
reflect on the first ever
Raspberry Jamboree held at
the Manchester Central
Conference Centre on 9th
March 2013

MMYY SSTTOORRYY

It started with Ubuntu 07.10
when a friend showed me a

Knoppix Live-CD, and then I
Googled about it, found Ubuntu
and asked for a CD from ShipIt.

At this time I had an HP laptop
with a 1.7 GHz Centrino Mobile
processor and 768 DDR Ram. I dual
booted it with XP and I loved
Ubuntu. I didn't notice big
performance gains but I loved the
idea of open source software.

The only problem was that I
couldn't connect Ubuntu to the
Internet. I was then in Central Asia
and had to connect to the Internet
thru PPPoE protocol or something
like that, and it was impossible to
do it in Ubuntu, for me at least. So
I had my laptop connected to a PC
with XP thru a wired connection in
order to have Internet on my
laptop.

Also, there was a very powerful
dictionary that didn't run in Wine,
so eventually I used XP most of the
time. However, I started to use
open source software in XP
whenever it was possible, so I

installed Thunderbird, Firefox,
OpenOffice, etc.

Then I moved to another
country in 2009 and bought my
current laptop, an Asus K50ij from
BestBuy. Ubuntu worked great but
the webcam was upside down so I
eventually stopped using Ubuntu
and used Win7 a lot more. In time,
the camera issue was fixed but not
in Skype. I Googled a lot and found
a transitory solution that fixed the
issue, but I had to do it every time I
logged into my session*. So, again I
eventually started to use Win7
because it didn't have that
problem.

I wish I could fix that issue and
use Ubuntu 12.04, which I really
liked. I liked also Lubuntu and
Bodhi Linux because I could see
significant performance gains, but
the issue in Skype appeared on
those distros as well.

Right now I use only Win7 and I
hope to have more luck when I buy
another laptop. I don´t think it will
be in the near future because my
laptop works great so far, and

laptops have become very
expensive in my country. It´s a pity
because I don´t use Russian a lot
anymore and there are places like
Wictionary and others that do the
job very well. However, Skype is a
must for me now. My friends don't
use Google Talk, which could be a
replacement for Skype, so it's Win7
for the moment but I am looking
forward to going back to Ubuntu.
Also, I don´t like to dual boot.

* Gord notes: This web page may
have the solution:
http://pc-freak.net/blog/how-to-
fix-upside-down-inverted-web-
camera-laptop-asus-k51ac-issue-
on-ubuntu-linux-and-debian-gnu-
linux/
But don't access it in Windows --
the site might contain malware.

Written by Juan Martin Sierra

http://blackpool.lug.org.uk
http://fullcirclemagazine.org
http://pc-freak.net/blog/how-to-fix-upside-down-inverted-web-camera-laptop-asus-k51ac-issue-on-ubuntu-linux-and-debian-gnu-linux/
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RREEVVIIEEWW
Written by Ronnie Tucker OOUUYYAA CCoonnssoollee

It all began in July 2012 with a
Kickstarter fund for the creation of
the Ouya, an independent gaming
console based on the Android
operating system. They asked for
nearly $1m. In the end, they
received almost $9m with 63k
backers. Impressive stuff. But is
the final unit impressive?

THE KIT

The Ouya itself is tiny. It’s
approximately 2.5” square (about
the length of your index finger),
has a round on/off button on the
top, and can safely fit in the palm
of your hand. On the back is an
HDMI port, USB port, network
socket, and a connector for the
power supply. The controller is

wireless, has a small touchpad
(above and between the d-pad and
right stick), and is about the size of
your average Playstation/Xbox
controller, but not as heavy. It has
the usual array of buttons (four),
two sticks, one d-pad, and four
shoulder buttons. Between the d-
pad and right stick is the Ouya
button.

Just for completeness, the
Ouya comes with a modified
Android OS which is listed on my
box (as of July 2013) as:

Build Number: 1.0.328_r1
Software Version: 1.0.6
Android: 4.1.2

THE SETUP

First boot is a bit fiddly—it
involves setting up your wireless,
signing up to Ouya, then giving
them your bank card details (for
app purchases)—all done through
the controller. Took a while, but I
got there in the end. Pairing your
controller to the console is easy
enough. You just hold down the

Ouya button (on the controller)
until it flashes two lights (from the
four at the top of the controller) at
which point it’s done and you can
proceed.

My only reservation, thus far,
was giving my bank card info to a
screen that could very well have
been insecure. Your browser will at
least display https or a nice
reassuring padlock symbol, but the
Ouya just presents a pretty screen.
At least try and assure me it’s
secure!

PLAY TIME

With all the necessary digital
paperwork done, you’re presented
with an orange screen displaying
four options; play, discover, make,
and manage.

http://www.htc.com/www/smartphones/htc-one-s/#specs
http://nostarch.com/gimp
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REVIEW - OUYA CONSOLE

Play - this lists your installed
apps/games.
Discover - this is the Ouya store
where you install/buy apps/games.
Make - this is more for devs, but is
where side-loaded apps appear.
More on that later.
Manage - this is the Ouya settings
screen.

First stop is ‘discover’ to install
some games. Under discover, we’re
given categories such as featured,
VIP (for games only on Ouya),
several playlists (from developers I
believe), showcase, trending, and
genres. Searching is done using the
yellow Y button.

Selecting a title takes you to its
info screen with options such as
download, rating, and more info.

Heading back to the main
screen and clicking ‘play’, you’re
presented with the games you’ve
installed. You can either click the
icon to load it, or press the blue ‘U’
button to get info on the game to
uninstall it if necessary.

From the main menu you can
click ‘make’ to get access to a web
browser (via the software option),
or click ‘builds’ for developer stuff.

The ‘manage’ option (in the
main menu) presents you with;
account, controllers, network,
notifications, and system.
Account - your Ouya account.
Think of this as being your Google
account in Android. In here, you
can set parental controls and edit
your payment settings.
Controllers - lets you re-pair or
add new controllers. Up to four
controllers can be added.
Network - lets you choose a
wireless network from those
detected.
Notifications - this where your
system messages are.
System - this presents you with:

Console Info - displays system

software versions
System updates - checks for

system updates.
Advanced - this is the

equivalent of Android Settings and
lets you turn on/off wireless,
bluetooth, look at storage used,
apps installed, and such-like.

Factory Reset - reset to factory
settings.

All menu items are quickly
displayed and there’s no lag that I
could see.

As of writing, there are only
about 200 games for the Ouya so
the range is quite limited. The only
things to hold my attention were
the emulators and the little crane

game. Others are interesting but
are either terrible to look at (some
classed as ‘retro’) or quite slow (I’m
looking at you Amazing Frog).
Thankfully, though, you can install
Plex and TuneIn on the Ouya so
even if you’re not a gamer you can
stream media to your TV using the
Ouya.

SIDE LOADING

Side loading is the process of
installing apps/games using the
Android APK file rather than the
Ouya store. Initially it’s fiddly, but
the easiest way is to use the Ouya
browser to install the Amazon
appstore. Yes, you can install the
Google Play store, but you’ll have
to hunt the internet to find an APK
file as Google doesn’t readily
distribute it (even once I did get it
installed it failed to run). Once the
Amazon appstore is installed, you
can browse (using the touch pad)
through all their stuff too, but, and
it’s a big but, not everything will
work on the Ouya even though it’s
Android. Things like Netflix work
just fine, but take things like
double taps to select items.

CONCLUSION
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REVIEW - OUYA CONSOLE
Will it usurp Sony or Microsoft?

Definitely not, but for about £99
($99), it’s an Android game console
(or media player) that you can plug
into your HD TV. It’s also still early
days for the Ouya. It’s a bit late in
coming, but I’m sure (I hope!) it’ll
garner a great amount of
developer/hacker interest. Build
quality is a bit ropey, but for £99
you really can’t expect much!

PROS:
• it’s small and cheap
• fairly powerful for such a small
box
• already has emulators for SNES,
Megadrive, C64, MSX, etc.
• can use the Amazon appstore for
Netflix, etc.

CONS:
• USB socket is a bit hit and miss.
Wouldn’t recognise my 8GB stick,
but had no problem with my 1GB
stick. Both were formatted as
FAT32.
• quite a few reports of buttons
sticking
• d-pad feels a bit cheap
• out of the box the range of
games and apps is very limited

UBUNTU FORUMS IS DOWN FOR MAINTENANCE

There has been a security breach on the Ubuntu Forums.

The Canonical IS team is working hard as we speak to restore
normal operations. This page will be updated with progress reports.

WHAT WE KNOW

Unfortunately the attackers have gotten every user's local
username, password, and email address from the Ubuntu Forums
database.

The passwords are not stored in plain text, they are stored as salted
hashes. However, if you were using the same password as your Ubuntu
Forums one on another service (such as email), you are strongly
encouraged to change the password on the other service ASAP.

Ubuntu One, Launchpad and other Ubuntu/Canonical services are
NOT affected by the breach.

FINDING HELP

If you're looking for a place to discuss Ubuntu, in the meantime we
encourage you to check out these sites:

http://reddit.com/r/ubuntu

https://plus.google.com/communities/107299007624972266094

http://ubuntu-discourse.org/

http://reddit.com/r/ubuntu
https://plus.google.com/communities/107299007624972266094
http://ubuntu-discourse.org/
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SSOOFFTTWWAARREE SSHHOOWWDDOOWWNN
Written by Tushar Bhargava TThhee MMuussiiccaall TTrriioo

Everybody loves listening to
music. However, no one

particularly likes managing their
music collection. That's where
music player applications come in.
From organizing your music
collection to automatically
retrieving the album art, they
make our lives much simpler. The
most famous, of course, is the
iconic iTunes. However, Linux has
its own bevy of feature-filled music
players, some with innovations
that surpass their Mac and
Windows counterparts. This article
is the story of the three front
runners, Linux's musical trio –
Amarok, Banshee and Rhythmbox.

SCRATCHING THE ITCH

According to a Wikipedia entry,
Amarok was originally created by
Mark Kretschmann to provide a
better alternative to XMMS – a
free music player that was popular
during that time.

On December 15, 2004, Aaron
Bockover made both an
announcement and a confession in
a seemingly innocuous blog post.

“I’ve never been 100% satisfied
with the audio player selection in
GNOME,” he wrote and went on to
announce a new project called
'Remix Player' which we know
today as Banshee. He also listed his
grievances with the current
options and most readers
concurred with his sentiments.
Thus, Banshee was created, like
most software projects, to scratch
an itch.

So our entire musical trio came
into being because their
developers wanted something
better. There may be several
differences among them, but
Amarok, Banshee and Rhythmbox

have similar origins.

THE USER INTERFACE

As an Ubuntu user, I am curious
to see KDE's offering – Amarok.
However, I am in for a rude shock,
an aesthetic outrage that is
Amarok's User Interface (UI). The
default UI has a business-like gray
tone which is rather an eyesore. It's
a 3-column UI – the first column
acts as the content browser and
has a search bar, the second is
Amarok's jewel, the context
browser (more about it later,) the
last column is the playlist manager.
The playback controls on the top
are fairly straightforward – a large

pause/play button, a track
progress bar, two arrow buttons
pointing to the next and previous
tracks and a circular volume dial.
The 'shuffle' and 'repeat' button,
however, are conspicuously (and
most inconveniently) absent. To
conclude, Amarok's UI, while
certainly not beautiful, is still fairly
usable.

Now to the GNOME contenders
– Banshee and Rhythmbox.
Banshee's UI is simple and elegant.
It is a 2-column interface, with the
second column being divided into 3
panes. The first column acts as a
navigator, it shows the 'Libraries'
for music, videos, audiobooks and
podcasts, along with 'Online
Media'. The second column shows
album art in the form of square
tiles. Not only does this make
finding your favourite song
effortless, but also makes Banshee
the most beautiful music player
application. Another pane allows
you to choose the artist whose
songs you wish to hear. The last
pane displays the songs from the
album you selected. Written down
badly like this, the UI sounds

http://www.htc.com/www/smartphones/htc-one-s/#specs
http://nostarch.com/gimp
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SOFTWARE SHOWDOWN

confusing but is actually extremely
intuitive. The playback controls
include a pause/play button,
forward and back buttons for the
next and previous song. A slide-
down volume control, a search bar,
a small but easy to use repeat
button at the bottom, and a
shuffle option integrated with the
forward button cover all the basic
features.

Rhythmbox has a nice, clean
and perfectly understandable UI. It
has a 2-column UI, very similar to
Banshee. The main difference is
that Rhythmbox places much less
emphasis on the cover art. The

album art is relegated to a small
corner at the bottom of the player.
Rhythmbox, however, has the most
comprehensive music playback
controls of the trio – a play/pause
button, forward and backward
buttons, a repeat button, a shuffle
button and an option to simplify
the music browser visibility with
just a single click. The icons are
well designed and convey their
purpose clearly. The aggregation
of all the controls in a single place
saves users time and puts the
focus back on the music, extremely
well thought out.

INTERNET INTEGRATION

In the midst of the controversy
over Napster and digital piracy, we
often overlook an important fact:
the Internet is a fount of free and
legal audio in the form of podcasts
and Internet Radio streams. A true
21st century music player should
take advantage of this reality.

Amarok certainly taps into the
power of the Internet. Choosing
the 'Internet' option in the
browser column reveals a variety
of Internet music sources - a
podcast directory, Librivox for
public domain audiobooks (works
like a charm), Magnatune, an
online music store that believes in

'Fair Trade' , the hastily named yet
surprisingly good 'Cool Streams' –
a collection of select radio streams
that spans all genres,
Jamendo.com – a digital platform
for artists to showcase their
creations, and, of course, the
ubiquitous Last.fm – for
recommendations and discovering
new music, a central tenet of the
Amarok philosophy.

Banshee also has an impressive
list of built-in Internet applications:
the Amazon MP3 store to buy
music legally, the comprehensive
'Miro Guide' to help you find new
podcasts (of particular note are
the shows under 'Linux and Free
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Software'), the Ubuntu One Music
store, a great alternative for those
who don't want to use Amazon's
music store, the enormous
Internet Archive, which has
everything from movies to
audiobooks to full concerts, all in
the public domain. And finally,
seamless Last.fm integration
allows you to scrobble your tracks
and receive recommendations
from the comfort of Banshee itself.

Rhythmbox also offers some
Internet integration features,
though less than the others.
Last.fm integration is present. The
'Radio' tab offers some Internet
radio stations, again spanning
several genres. An interesting
inclusion is Libre.fm – a website
that aims to provide a Free
Software alternative to Last.fm.
However, Rhythmbox lacks both a
podcast directory and an online
MP3 store. In terms of Internet
integration it is definitely far
behind the others and needs to
catch up.

ADDITIONAL NOTES,
FEATURES AND MUSINGS

For all the talk of dehumanizing
technology, I have yet to see a

software project that is not
anthropomorphic in nature. Our
musical trio is no exception. The
three music players have their own
unique features, philosophies and
whims. In my brief yet searching
acquaintance with them I stumbled
upon a few.

Did you know Amarok, the big
friendly wolf, craves human
feedback? How do I know this, you
counter? Well, under the 'Help'
option in the menu, Amarok has
two surprising options – 'Show
Feedback Icons' and 'Send a
comment to the developers'.
Clicking on either gives you a
chance to send your feedback to
the developers, either in the form
of a happy/sad emoticon or a fully
fledged comment. More
importantly, Amarok asks for your
email address so that the
developers can contact you back,
an impressive commitment to
improvement indeed. Amarok's
feedback icons are an idea that
should be picked up by all FOSS
developers, it is a simple yet
powerful step towards a better
next version.

Apart from feedback, Amarok
also has a philosophy: it aims to be
your companion in your music

journey, rather than a mere tool.
Amarok's powerful context
browser shows you the lyrics of
your current song, Wikipedia
entries of the artist, album and
song, even tabs for you to rock out
on your own. Last.fm integration
provides recommendations for
new music you might like as does
the 'Similar Artist' applet.
'Rediscover music' is definitely a
philosophy well proved by Amarok,
helping users find new music and
learn more about the music they
already have. Banshee and
Rhythmbox have similar 'context
panes' for lyrics and Wikipedia
entries, but activating them
requires some effort.

Banshee, meanwhile, has the
annoying tendency of suddenly
hanging when too great a demand
is made of it. Euphemistically
called 'memory issues', they
interfere with an enjoyable
listening experience. These need
to be addressed soon lest Banshee
become a distant memory in the
minds of audiophiles. Being able to
listen to music uninterrupted is of
tantamount importance. In fact,
Banshee's erratic performance was
the reason I switched loyalties to
Rhythmbox about three months
back.

Banshee also has some
skeletons in its closet, namely its
reliance on Mono – an open source
framework to allow Microsoft .NET
to run on Linux. Critics fear that
Microsoft can cripple Mono with
patent suits which in turn will lead
to an early demise for Banshee. In
a sense these critics are the real
banshees with their warnings of
death. However, regular Banshee
contributor David Nielsen ridiculed
these fears and called them
'completely unfounded'. He argued
that even Microsoft today deploys
Mono. Banshee maintainer
Bertrand Lorentz added, ”If there
are any patents they would be on
specific ways to implement certain
features, so any other media
player with a similar feature would
be as much at risk as Banshee.”
After sifting through the evidence,
even I am of the opinion that we
are being too alarmist in the case
of Mono.

That leaves us with Rhythmbox,
in which I see traces of an awed
adolescent fan. Its idol? Apple's
iTunes. The official project
website, almost simpering, informs
users that Rhythmbox is 'inspired'
by iTunes. When I asked the entire
community where Rhythmbox

http://projects.gnome.org/evince/
http://okular.kde.org/
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'Software Showdown' in the subject.

SOFTWARE SHOWDOWN
surpassed iTunes, I did not receive
a single reply (at the time of
writing). Of the three music
players, Rhythmbox is probably the
project that needs to innovate the
most, a good UI can take it only so
far.

CONCLUSION

So which music player is the
best? Objectively speaking it's
Banshee. Not only is the UI
beautiful and easily
understandable, but also it is
packed with features. The
seamless Internet integration will
be much appreciated by users. The
only criticism I have is of the
resources the program consumes
and the frequent 'blackouts' when
it hangs. However, if your
computer is fairly modern,
Banshee will probably hang less
often.

I have to admit, though, I was
very impressed by Amarok – its
features, philosophy and the
inbuilt feedback options. If Amarok
acquires a beautiful UI to cloak its
powerful music player features,
and provides users the sorely
needed 'shuffle' and 'repeat'
buttons, it may well become the

undisputed king of music players.

Rhythmbox is the perfect
choice for those who want to only
listen to their music collection. It
doesn't hang and has perfect
playback controls. However, in
terms of features and Internet
integration it still lags far behind
the other two.

SUMMARY – AMAROK

The Good
• Powerful context browser that
provides song lyrics, Wikipedia
entries and more
• Great Internet integration
options
Inbuilt feedback options ensure
better next iterations
• Advanced playlist creation
options
Best album art retrieval

The Bad
• An ugly default UI
• Lack of 'shuffle' and 'repeat'
buttons can be extremely
frustrating
• Using the volume dial can be
slightly inconvenient, sometimes
even confusing

Website: http://amarok.kde.org/

SUMMARY – BANSHEE

The Good
• Beautiful and intuitive UI with
emphasis on album art
• Great Internet integration
options
• Context pane works well and
enhances the music listening
experience
• Simple and comprehensive
playback controls
• Stunning 'Now Playing' screen
with a 'Simplify' button

The Bad
• Resource hungry program, hangs
very frequently
• Certain features like the context
pane require some effort to
activate

Website: http://banshee.fm/

SUMMARY – RHYTHMBOX

The Good
• Clean and simple UI

• Comprehensive playback controls
aggregated in one place
• Libre.fm is an interesting Free
Software inspired alternative to
Last.fm
• One click 'Simplify' button allows
you to quickly change the UI to fit
your needs

The Bad
• Limited Internet integration
• Lack of features as compared to
Banshee or Amarok
• Reliance on Last.fm for album art
retrieval
• Album art is not displayed to its
full advantage

Website:
http://projects.gnome.org/rhythm
box/

THE WINNER OF THIS

SOFTWARE SHOWDOWN IS

Banshee.

mailto:tushar1995@gmail.com
http://projects.gnome.org/evince/
http://amarok.kde.org/
http://banshee.fm/
http://projects.gnome.org/rhythmbox/
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LLEETTTTEERRSS
If you would like to submit a letter for publication, compliment
or complaint, please email it to: letters@fullcirclemagazine.org.
PLEASE NOTE: some letters may be edited for space.

VOICE COMMANDS

First, great job on FCM. I've
been reading it right from the

start, and, even though I've moved
from Ubuntu to OpenSuse (thanks
Unity!), I still find the articles
useful.

Second, would it be possible to
include an article on doing basic
tasks in Linux (launch a program,
bring a background window to
focus, etc) using voice commands?
I've been in IT for nearly 15 years
now and the fingers are aging.

Soumen

Ronnie says: The onlything I could
find, aftera quickGoogle, was

Palaver. Needs compiling, but if
you're interestedhere's a short

tutorial (notours) on howto install

Palaver:

http://www.muktware.com/5412/h

ow-get-palaver-speech-recognition-

work-ubuntu

Ifyou do install anduse it, letus

knowwhatyou thinkofit.

SOLYDK BACK OFFICE

In FCM#73, I took a good look at
your survey. There was a

question asking what people use
Linux for, and I found that quite a
few people use Linux in
businesses.

I'm a business consultant by
trade, and have a special interest
in how people use Linux for their
businesses.

A week ago I launched SolydK
Back Office: a SolydK variant that
supports the main business
processes. A few professors are
interested in using it in class for
management students at their
universities, but business users
haven't contacted me yet.

Maybe you know of people with
business interests, and would like
to take a look at SolydK BO? You
can find more information here:
http://solydxk.com/products/solyd
kbo

Schoelje

CLEMENTINE

I found the review of Clementine
in FCM#74 interesting. However,

the reviewer failed to mention one
thing that makes it totally useless
for me in that, unlike both
Rhythmbox and Banshee, it will not
play music from my network
DLNA/iTunes server.

Ian Pawson

Join us on:

facebook.com/fullcircle
magazine

twitter.com/#!/fullcirclemag

linkedin.com/company/full-
circle-magazine

ubuntuforums.org/forum
display.php?f=270

goo.gl/FRTMl

FULL CIRCLE NEEDS YOU!

Without reader input
Full Circle would be an

empty PDF file (which I don't
think many people would find
particularly interesting). We
are always looking for articles,
reviews, anything! Even small
things like letters and desktop
screens help fill the magazine.

See the article Writing for Full
Circle in this issue to read our
basic guidelines.

Have a look at the last page of
any issue to get the details of
where to send your
contributions.

mailto:letters@fullcirclemagazine.org
http://facebook.com/fullcirclemagazine
https://twitter.com/#!/fullcirclemag
http://linkedin.com/company/full-circle-magazine
http://ubuntuforums.org/forumdisplay.php?f=270
http://goo.gl/FRTMl
http://www.muktware.com/5412/how-get-palaver-speech-recognition-work-ubuntu
http://solydxk.com/products/solydkbo
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QQ&&AA
Compiled by Gord Campbell

If you have Ubuntu-related questions, email them to:
questions@fullcirclemagazine.org, and Gord will answer them in a future
issue. Please include as much information as you can about your problem.

Q Every time I open the lid of
my laptop, Ubuntu requires

me to enter my password. How do I
disable this?

A (Thanks to ubudog in the
Ubuntu Forums) In System

Settings, under Brightness and
Lock, change the "Lock screen
after" setting.

Q I have a folder in my home
directory that I want to add to

the "Places" sidebar.

A In Ubuntu 13.04, open the
folder in the File Manager. At

the top-right of the window there's
a gear, click on it and choose
Bookmark this Location.

Q I have a .deb from a trusted
source. When I double-click on

it, I see what is inside. How can I
install it?

A Right-click on it and select
"open with" GDebi.

Q I tried to install Ubuntu, and
wound up wiping out my

Windows system -- and all my
priceless data. How can I recover?

A Stop using the computer
immediately! You may be able

to recover some of your data,
maybe a lot of your data.

Remove the hard drive from the
computer. If this is your only
computer, buy another hard drive,
install it, then install Ubuntu. If you
don't already own a USB adapter
for an external hard drive, buy one,
(I've used a couple which cost less
than $10.) Install Testdisk and
Photorec and read about how to
use them. Select the one which
seems most likely to be useful.
Plug in your old hard drive as an
external drive. Run your chosen
data recovery package, and see
what happens.

Q Will the Tesseract OCR
program be faster than

looking at an image and typing the
text into a file?

A No, you will spend more time
correcting Tesseract's output

than if you just typed it in from
scratch.

Q How can I set my keyboard
permanently to Portuguese?

A (Thanks to papibe in the
Ubuntu Forums) Open

'Keyboard Layout', add the
Portuguese keyboard by pressing
the + symbol, then move it to the
top of the list or remove the other
layouts.

Q I have done the latest updates
on Xubuntu 12.04 and noticed

it has not been asking me for my
password to authenticate it?

A Yes, that's the new normal.
See http://goo.gl/DNlIX

Q I modified an important file,
and can't boot into the

graphical system. When I boot into
recovery mode, the filesystem is
read-only. How can I fix the file I

messed up?

A (Thanks to Cheesemill in the
Ubuntu Forums) In recovery

mode, enter this command, which
will let you edit the file:

mount -o rw,remount /

Q I have the "backports"
repository activated in Mint

13, so I get the newest versions of
Cinnamon. I understand the Mint
team has forked Nautilus, but
when I click on File Manager, I still
get Nautilus.

A Open a terminal and enter
this command: nemo

If you decide you want to make
nemo your default file manager, go
to this web page:
http://www.fandigital.com/2013/0
1/set-nemo-default-file-manager-
ubuntu.html

As well, there is a file manager
in the panel, which requires further
work. Right-click on it and select
"Edit". Change the Application

mailto:questions@fullcirclemagazine.org
http://goo.gl/DNlIX
http://www.fandigital.com/2013/01/set-nemo-default-file-manager-ubuntu.html
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Q & A
from nautilus to nemo, click on
Update.

Also, there is a (nautilus) File
Manager on the left side when you
click on Menu. Simply drag it into,
say Accessories. When you open
Accessories, you might see an
entry labelled Files, which you can
drag to the left side of the Menu.
You may want to edit menu
entries, install Alacarte, which gets
installed as "Main Menu".

Q I bought a USB turntable to
convert my vinyl collection to

computer files, but it doesn't work
very well.

A Just bit-torrent download the
tracks you legitimately own. I

was capturing my favorite tracks,
turntable to amp to line-in to
Audacity. My son challenged me:
"can you capture a track faster
than I can bit-torrent it?" It wasn't
close.

If you own a vinyl record, it is
completely legal for you to
download an MP3 of that record;
it's called "backup." Mind you, I am
not a lawyer, so I can't provide
legal advice. My guru on copyright
is Brad Templeton:

http://www.templetons.com/brad/
copymyths.html (By complete
coincidence, I have known Brad
since he was in high school.)

The starting point is Google. For
example, I own Art Garfunkel's
Breakaway album, and one of the
songs is "I only have eyes for you."
So I Google "I only have eyes for
you garfunkel torrent" and get
several results. The second one
takes me to a site where there's a
download link for a "torrent" file.
(Torrents are quite small, typically
a few dozen KB.) In my file
manager, I right-click on the
torrent, and select "open with
Transmission...." Transmission
opens up, but we're not quite
done. I need to select the file I
want and then click on "open." If
you're lucky, the MP3 will be on
your system in a few minutes.

The system is not perfect. You
will come across sites which want
you to install a "download
manager" (for Windows) and most
of them are pure malware.

You will also see the terms
"seeders" and "leechers." A seeder
is a person who is offering a file, a
leecher is downloading. If you want
a file and there are no seeders, you

will never get it.

It's worthwhile to become
familiar with bit torrent
downloads, because on the day a
new version of Ubuntu is released,
by far the best way to get it is by
bit torrent.

Clarification: the actual torrent I
selected was for the entire
Breakaway album -- and it
downloaded in less time than it
took to write this.

Note: music files aren't very big,
a typical MP3 is less than 10 MB.

Second note: there's one
possible legal glitch with bit
torrents. As soon as you have some
of the file downloaded, you
become a "seeder," so you might
be providing the file to people who
do not have the legal right to
possess it. That has the possibility
of getting you into legal hot water.

Q I asked a question in the
Forums, and got no response.

How can I keep it active?

A Wait at least 24 hours, and
Reply with the word "Bump."

Even better, wait 36 hours, and you

will expose the question to people
in a different set of time zones.

FROM THE UBUNTU NEWS

DIGEST, ACTIVE AND TOP

QUESTIONS AT ASKUBUNTU:

* What does ~$ stand for?
http://goo.gl/BORVA

* What's the best way to SSH to
machines on the local network?
http://goo.gl/4Zu3q

* How to take ownership over an
existing Ubuntu Software Center
app?
http://goo.gl/7xc7f

* Run a command with the
argument from the last command
http://goo.gl/EhARr

* Ubuntu routing table with 3 NICs
http://goo.gl/m01fR

* May I speak with someone about
these applications for a grant
proposal I am writing?
http://goo.gl/LEmC1

* How to install multiple versions
of LibreOffice?

http://www.templetons.com/brad/copymyths.html
http://goo.gl/BORVA
http://goo.gl/4Zu3q
http://goo.gl/7xc7f
http://goo.gl/EhARr
http://goo.gl/m01fR
http://goo.gl/LEmC1
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After a long career in the computer
industry, including a stint as editor of
Computing Canada and Computer
Dealer News, Gord is now more-or-
less retired.

Q & A
http://goo.gl/dUfZY

* Auto complete for often used
command line commands?
http://goo.gl/GkkHE

* Where can I order a CD of
Ubuntu?
http://goo.gl/yT9M0

* Differences between /bin, /sbin,
/usr/bin, /usr/sbin, /usr/local/bin,
/usr/local/sbin
http://goo.gl/1eNld

* What is the difference between
dpkg and aptitude/apt-get?
http://goo.gl/zuZvD

* How often is the password asked
for sudo commands? Where can I
set it up?
http://goo.gl/rGj4A

* Difference between "ppa-purge"
and "add-apt-repository -r"?
http://goo.gl/g7t0F

* Some fast way to save and
restore tabs of Terminal?
http://goo.gl/RJ6cS

* How do I show a message with
username and date at login?
http://goo.gl/Vg3Od

* Why can't I connect to wired
Internet with fixed IP address
http://goo.gl/mUVQv

* WiFi issue after installing laptop
mode tools
http://goo.gl/VtNU5

* Data on hard drive (erased by
installing Ubuntu?)
http://goo.gl/uW8Wl

* what is the difference between
cd \ and cd / commands in Ubuntu
terminal?
http://goo.gl/B6Mxc

* Corrupted Windows 7 Registry,
trying to install Ubuntu and delete
Win7
http://goo.gl/JT8X9

* Is there any program for writing
a book?
http://goo.gl/OGdWG

* I installed 64-bit OS in 32-bit
Processor (or not...)
http://goo.gl/nO1wx

* Total Newbie confused about
partitions
http://goo.gl/z12sM

* I want to know when a running
process will terminate. How can I

watch it?
http://goo.gl/UoprN

* Is it possible to use Python with
the Ubuntu SDK?
http://goo.gl/pY2le

TIPS AND TECHNIQUES
Clean-up Time

Regular readers know that I
track the temperatures of the

various components of my
computer like a hawk. I recently
realized that my desktop was
running warmer than when it was
new, so it was clean-up time.

I keep my computer on a desk,
sideways, with the monitor in front
of it. Step one was to unplug
everything, then move everything
but the system unit out of the way.
Then I could carry the system unit
to my dining-room table where
there was room to operate.

The family vacuum cleaner was
on the agenda, using the "crevice"
tool. Everything which looked like a
vent was pretty much covered with
a blanket of dust; the vacuum
made short work of it. Don't forget
USB ports, Firewire ports, audio

ports. My desktop has a front
panel which pops off, with a filter
behind it. I was surprised to see
that the filter was pretty clean.

Take off the side panel.
Surprise, there's hardly any crud
inside the box. Physically remove
the video card from the computer.
My video card has a fan and a heat-
sink with fins. Tiny dust bunnies
were living in the fins. A Q-tip
cleaned them out. Put the video
card back, restore the side panel,
put everything back where it was.

Did it work? I was surprised by
how well it worked. Measuring
everything at idle, the temperature
of the hard drive dropped by a full
six degrees C. The video card?
Twelve degrees. The CPU didn't
drop by much, but I can see a big
difference when it's running flat-
out. Time well spent!

http://askubuntu.com/questions/298842
http://goo.gl/dUfZY
http://goo.gl/GkkHE
http://goo.gl/yT9M0
http://goo.gl/1eNld
http://goo.gl/zuZvD
http://goo.gl/rGj4A
http://goo.gl/g7t0F
http://goo.gl/RJ6cS
http://goo.gl/Vg3Od
http://goo.gl/mUVQv
http://goo.gl/VtNU5
http://goo.gl/uW8Wl
http://goo.gl/B6Mxc
http://goo.gl/JT8X9
http://goo.gl/OGdWG
http://goo.gl/nO1wx
http://goo.gl/z12sM
http://goo.gl/UoprN
http://goo.gl/pY2le
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UUBBUUNNTTUU GGAAMMEESS
Written by Ronnie Tucker

While driving a large
behemoth of a truck

through some long, winding roads
throughout Europe may seem dull
and boring, it’s actually quite
addictive! And hypnotic -- but with
a touch of road rage thrown in for
good measure.

INSTALLING

Euro Truck Simulator 2 (ETS2)
for Linux is installed via Steam. You
purchase the Windows game
through Steam as you normally
would and let it install. Once the
Windows version is purchased and
installed you need to go to Steam >
Library and right-click on Euro
Truck Simulator 2 and choose
Properties. In the window that
pops up, click the Betas tab. Now
you’ll see a list of available betas.
As of writing (July 2013), you
should choose linux_testing. This
will install the Linux launcher and
let you launch ETS2 using Steam.

TRUCKIN’

The idea behind the game is

two-fold. You can either stay as a
driver for hire – doing odd jobs for
other companies – or (and more
likely), you form your own company
and accept jobs. With that, though,
come responsibilities such as
having to get a bank loan to buy a
truck, paying off that loan, having
to repair your truck from your own
savings, and taking the blame
when you damage the goods.

Once your company is on its
legs, you can upgrade your base
and hire other drivers to help your
cash flow. Of course, this means
more bank loans, buying more

trucks, paying for their damages,
lateness and so on. No easy task!

While sitting in your truck, you
can check a map of Europe and see
all the jobs available. You can filter
them by locations, distance,
money, and so on. From within
your warm cabin, you have access
to GPS data (showing you your
route), job info, a button to
request help (ie: you’ve tipped the
truck and can’t move), and several
other pieces of info. All of which
come in handy at some point. You
also have to remember to keep an
eye on your fuel level and your

alertness. As you drive around,
your sleepiness icon will start to fill
up. If this reaches red then you’ll
be warned to pull over (in a
designated area, not just
anywhere!), and sleep. If not, you’ll
be continually fined until you do
sleep. Seems simple enough, but if
you’re job requires you to be there
in three hours (in game time), and
you forgot to take a nap
beforehand, then you could be
forced to take a rest and turn up at
your destination late. Not good.

Anyway, that’s the basics of the
game. Take jobs, deliver stuff,
don’t crash. There is more to it
such as upgrading trucks, adding
beacons, and what have you.

GRAPHICS

The visuals for ETS2 are
absolutely stunning. Out of the
blue, the skies will darken and it’ll
chuck it down. The droplets of rain
hit your windscreen and smear as
you tear down the road. Don’t
worry though, you have
windscreen wipers. If it’s dark, you
must turn on your lights, of course,

EEuurroo TTrruucckk SSiimmuullaattoorr 22
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UBUNTU GAMES
and your lights illuminate the road
ahead giving a glow to anything
white and lighting up traffic cones
and the like. On a sunny day, you’ll
see the sunbeams stream through
the trees casting shadows on the
road. I usually end up veering all
over the road because I’m too busy
looking at the scenery.

The physics behind the game
are also excellent. Using external
camera views lets you see every
suspension bump of your truck. AI
is also good, sometimes too good,
as at times the other drivers really
do act like human drivers by
overtaking at dangerous times,
blocking the road... you get the
idea.

Obviously the makers can’t
replicate the whole of Europe in a
game, but they have included
recognisable landmarks from most
cities in the game. Which is a nice
touch.

CONCLUSION

I was wary of buying ETS2, but
I’m really glad I did. It’s a great
game for just dipping into when
you feel like it. Fire it up, take a
job, maybe take another. I love that

aspect of it. The one big downside
to ETS2, though, is the lack of a
Linux demo to try out your
hardware. You have to use Steam
to buy ETS2, then, once you’ve
bought it, you can download the
Linux client to start it up. No demo
is the one thing that almost
swayed me away from ETS2 and is
something the makers should
rectify, as I’m sure it puts a lot of
people off.

I like the idea that you’re not on
rails either. Many times I’ve not
been paying attention, missed a
turn off, and had to drive for miles
before I could find a place to do a
highly illegal u-turn to get back on
track. While you are expected to

follow some laws, whether you
decide to indicate is entirely up to
you. Same with you deciding to
mount the pavement to skip
queues -- not that I’d ever do such
a thing. Arriving at your
destination, it’s up to you whether
you want to try and park the truck
(much harder than it looks) or just
skip it.

Time in the game is not real-
time. When a job says it’ll take 16
hours including a cross channel
ferry, don’t panic! It will certainly
take an hour of your time to do,
say, an 8-hour job, but it’s always
eventful. Especially since the
game/GPS seems to love taking me
down some small twisty roads

when it’s dark and I have a wide
load.

Yes, it does sound like the most
boring game in the world, but I
definitely recommend it.

PROS:
• Amazing graphics if your machine
can handle it.
• Many different ways to drive your
truck (I use keys to drive and the
mouse to look).
• Dozens of cities to visit.
• Doesn’t keep you on rails.

CONS:
• No Linux demo.
• Takes a hefty machine to play.
• No in-cab radio/music due to MP3
licensing issues.
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MMYY DDEESSKKTTOOPP Your chance to show the world your desktop or PC. Email your screenshots and
photos to: misc@fullcirclemagazine.org and include a brief paragraph about your
desktop, your PC's specs and any other interesting tidbits about your setup.

I use Mint 13 with the standard
gnome 3 shell. The calendar and
mem/cpu meter are screenlets.

I like the 'bare' look of the standard
gnome. I hate icons or fancy menus
on the desktop. Less is more.

From this you will gather that I
absolutely hate the look of KDE!

Ian Pawson

mailto:misc@fullcirclemagazine.org
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System specs:
CPU: AMD Phenom II X2 @ 3.1 GHz
Memory: 4 GB
Hard drive: 640 GB
Graphics: Nvidia 9400 GT

OS: dual boot 64-bit Linux Mint 13
with Cinnamon, and Xubuntu 13.04
(plus Ubuntu 12.04 and Ubuntu
13.04 in Virtualbox, and Windows 8.1
Preview on a separate hard drive)

The background is a picture I took
myself at Niagara Falls.

Gord Campbell

MY DESKTOP
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This desktop screenshot is from
my home computer, running

Ubuntu 10.04 on an Intel D945GCPE
board with a Core 2 Duo 6320 proc
at 1.86Ghz, onboard graphics card

and 2 GiB RAM. 3 internal HDD of
sizes 320GB, 500GB and 750GB, all
of them WD, and two external HDD
each of them of 1TB, one Toshiba
and the other Seagate. The modem
is an Agere Systems Lucent V.92.

GNOME 2.30 Desktop Environment
with some modifications.

I think my Desktop isn't pretty and is
very unorganized, but it can show
that in Linux you can do things your

way, no questions asked, regardless
of the unholy mess you prefer.

Aliet Expósito García

MY DESKTOP
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My Desktop:
Operating System: Ubuntu 13.04 64-
bit
Desktop Environment: Unity
Gtk3 Theme: Mediterranean Light

Darkest
Icon Set: Cornucopia (my own
compiled icon set derived from FS
Icon set)

Hardware:
Motherboard: Gigabyte-H61M-S2P-
B3
Processor: Intel Core i3-2100 CPU @
3.10 GHz × 2

Graphics: Intel Sandybridge Desktop
4 GB RAM and 500 GB memory

Rohan Pinto

MY DESKTOP
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HHOOWW TTOO CCOONNTTRRIIBBUUTTEE
Full Circle Team

Editor - Ronnie Tucker
ronnie@fullcirclemagazine.org
Webmaster - Rob Kerfia
admin@fullcirclemagazine.org
Podcast - Les Pounder & Co.
podcast@fullcirclemagazine.org

Editing & Proofreading

Mike Kennedy, Lucas Westermann,
Gord Campbell, Robert Orsino,
Josh Hertel, Bert Jerred

Our thanks go to Canonical, the many
translation teams around the world
and Thorsten Wilms for the FCM logo.

FULL CIRCLE NEEDS YOU!
A magazine isn't a magazine without articles and Full Circle is no
exception. We need your opinions, desktops, stories, how-to's,
reviews, and anything else you want to tell your fellow *buntu users.
Send your articles to: articles@fullcirclemagazine.org

We are always looking for new articles to include in Full Circle. For help and advice
please see the Official Full Circle Style Guide: http://url.fullcirclemagazine.org/75d471

Send your comments or Linux experiences to: letters@fullcirclemagazine.org
Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org
Questions for Q&A should go to: questions@fullcirclemagazine.org
Desktop screens should be emailed to: misc@fullcirclemagazine.org
... or you can visit our forum via: fullcirclemagazine.org

FCM#76
Deadline:
Sunday 11th Aug. 2013.
Release:
Friday 30th Aug. 2013.

EPUB Format - Recent editions of Full Circle have a link to the epub file on the downloads page. If you have any problems with
the epub file, you can drop an email to: mobile@fullcirclemagazine.org

Google Currents - Install the Google Currents app on your Android/Apple devices, search for 'full circle' (within the app) and
you'll be able to add issues 55+. Or, you can click the links on the FCM download pages.

Ubuntu Software Centre - You can get FCM via the Ubuntu Software Centre: https://apps.ubuntu.com/cat/. Search for 'full
circle', choose an issue, and click the download button.

Issuu - You can read Full Circle online via Issuu: http://issuu.com/fullcirclemagazine. Please share and rate FCM as it helps to
spread the word about FCM and Ubuntu Linux.

Ubuntu One - You can now have an issue delivered to your free Ubuntu One space by clicking the 'Send to Ubuntu One' button
which is available on issues 51+.
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